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Overview

This manual covers the following topics related to your FLIR TCX Series thermal camera:

¢ Web browser configuration interface: See 4 Web Configuration Setup, page 5.

¢ Firmware upgrade tool: See 13 Firmware Upgrade Tool, page 137.

¢ Central Management Software for PC / Mac: See 9 Connecting to Cameras with
FLIR Cloud™ CMS, page 67.

¢ Smartphone / tablet apps: See 11 Smartphone and Tablet Apps, page 95.

@ NOTE

* For physical installation instructions, please refer to the Quick Connection Guide for your camera
model.

* Some settings described in this manual may not be available depending on the features supported
by your camera model.
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Thermal Imaging Overview

The Tri-Mode IP/MPX/Analog Thermal camera is a state-of-the-art thermal imaging de-

vice that will provide excellent night visibility and situational awareness without any form
of natural or artificial illumination. The sensors do not produce images from visible light

like an ordinary camera or the human eye does. Thermal cameras use energy in the in-

frared band to produce images by sensing subtle differences in temperature and gener-
ating images based on those differences.

By using a thermal camera, you are viewing heat, not light. If there is a person in the live

view image, you can see there is a person, but identifying who that person is may be im-

possible regardless of the resolution of your thermal sensor. Similarly, while a higher res-
olution sensor will detect a person at a greater distance, a low resolution sensor in many
cases will still detect the same motion.

The thermal imaging sensor relies on the fact that all objects, even very cold objects like
ice, emit thermal energy in the portion of the spectrum that the sensor can detect, the
long wave infrared (LWIR). Therefore, unlike a visible-light camera, the thermal imaging
sensor produces images based on directly radiated rather than reflected energy.

Any scene displayed by the sensor contains a range of thermal energy (temperatures),
from the lowest to the highest, that is present in the scene. These temperatures are
grouped by the sensor into a maximum of 256 “shades of gray” based on the thermal im-
age processing settings. Since the TCX Series camera is sensitive enough to distinguish
many more than 256 different temperatures, each “shade of gray” will represent a range
of temperatures.

For example, in a simplistic case, an image comprised of 60% sky (very cold) will devote
60% of the available “shades of gray” to the sky, leaving only 40% for the remainder of
the image. The temperature range assigned to each “shade of gray” is controlled by the
choices in the Camera Settings menu or the MPX on-screen display (OSD).

FLIR Systems, Inc. offers a comprehensive selection of training courses to help you to
get the best performance and value from your TCX Series cameras. You can find out
more at www.flir.com/training.
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Tri-Mode IP/MPX/Analog
Overview

The cameras offer three video output modes: standard analog, high definition (MPX),
and IP.

* IP/PoE: Provides high definition video output through Ethernet. If you are not using
PoE, make sure to connect the camera to a power source.

* MPX: Provides high definition video output through a BNC connector. To use MPX
mode, insert the MPX terminator into the camera’s Ethernet cable before you power
on the camera. When the terminator is installed, IP / POE mode is not available. If the
camera is powered up without the terminator installed, IP and analog mode is enabled.

MPX terminator

¢ Analog: Provides high definition video output through a BNC connector.

@ NOTE

After the camera is powered on, it may take up to 2 minutes for the camera to fully boot up and show a
picture.

3.1 Connecting the Camera

@ NOTE

Actual alarm lead configuration may differ from the configurations shown below. Always refer to the
alarm lead tag for a full description.

Mid Bullet Alarm

The camera can activate an external alarm with an output signal when provided with an
external voltage from an alarm receiving device. The camera can accommodate a DC

powered device (maximum 2 A @ 30 Vdc) or an AC powered device (maximum 0.5 A @
125 Vac). When an alarm event occurs, the camera closes an internal relay which com-
pletes the circuit. The camera can only operate as a normally open (NO) switch device.

1. ALARM_COM

2. ALARM_NO
=] —
= —
= —
2 ——r= —
| ——c= —

The camera can receive two external alarms with input signals provided by an exter-
nal switch closure. The camera provides two TTL voltage circuits (maximum 5 Vdc).
When the camera senses an external switch closure (which completes the circuit),
an alarm event occurs. The camera can be configured to sense input signals either
as normally open (NO) or normally closed (NC).

3. ALARM_IN1
4. ALARM_IN2
5. ALARM_GND

5 = —

4 —

3 == -

= —
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Tri-Mode IP/MPX/Analog Overview

PTZ Alarm

The camera can activate an external alarm with an output signal when provided with an
external voltage from an alarm receiving device. The camera can accommodate a DC
powered device (maximum 2 A @ 30 Vdc) or an AC powered device (maximum 0.5 A @
125 Vac). When an alarm event occurs, the camera closes an internal relay which com-
pletes the circuit. The camera can only operate as a normally open (NO) switch device.

1. ALARMOUT_1
2. ALARMCOM_1

NEAA

D —

| ——f

The camera can receive two external alarms with input signals provided by an exter-
nal switch closure. The camera provides two TTL voltage circuits (maximum 5 Vdc).
When the camera senses an external switch closure (which completes the circuit),
an alarm event occurs. The camera can be configured to sense input signals either
as normally open (NO) or normally closed (NC).

3. ALARMGND
4. ALARMIN_1
5. ALARMIN_2

5 =T —

4 e =g —

3 —c= =

= —

— —
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Web Configuration Setup

The camera includes a built-in web interface that can be accessed using a web browser.

4.1

Supported Browsers

* Google Chrome™, Mozilla Firefox®, and Apple Safari® (via Webplugin)
¢ Microsoft Internet Explorer® 8.0 or later, 32-bit version (via ActiveX®)

4.2
1.

4.3
1.

Internet Explorer Setup

Open Internet Explorer® and enter the camera’s IP address in the address bar in the
following format: http://IP address:HTTP Port.

e For example: http://192.168.0.100:80
¢ The IP address can be found using the FLIR Cloud CMS. See 9.3 Adding a Cam-
era over the Local Network (LAN), page 68 for details.

A notification bar appears asking if you would like to install ActiveX® plugins. Click
Install or Allow to install the plugins.

Enter the camera user name (default: admin) and password (default: admin) and
click Login.

Safari Setup

Open Safari® and enter the camera’s IP address in the address bar in the following
format: http://IP address:HTTP Port.

e For example: http://192.168.0.100:80
e The IP address can be found using the FLIR Cloud CMS. See 9.3 Adding a Cam-
era over the Local Network (LAN), page 68 for details.

A notification appears asking if you want to use the NPMedia plug-in. Click Trust to
use the plug-in.
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Web Configuration Setup

3. Enter the camera user name (default: admin) and password (default: admin) and

click Login.

@ NOTE

If video from the camera does not appear after installation, quit Safari® by right-clicking on the Sa-
fari® icon in the dock and then selecting Quit. Then restart Safari® and log back into your camera.

4.4 Firefox Setup

1.

Open Firefox® and enter the camera’s IP address in the address bar in the following
format: http://IP address:HTTP Port.

¢ For example: http://192.168.0.100:80
¢ The IP address can be found using the FLIR Cloud CMS. See 9.3 Adding a Cam-
era over the Local Network (LAN), page 68 for details.

A notification appears asking if you want to use the MMX plug-in. Click Allow... to
use the plug-in.

Enter the camera user name (default: admin) and password (default: admin) and
click Login.

@ NOTE

If video from the camera does not appear after installation, quit Firefox® by closing the browser
window. Then restart Firefox® and log back into your camera.

4.5 Google Chrome Setup

1.

Open Chrome™ and enter the camera’s IP address in the address bar in the follow-
ing format: http://IP address:HTTP Port.

e For example: http://192.168.0.100:80
¢ The IP address can be found using the FLIR Cloud CMS. See 9.3 Adding a Cam-
era over the Local Network (LAN), page 68 for details.
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Web Configuration Setup

2. Click Please click here to download and install the plug-in.

3. The plug-in downloads automatically. When finished, double-click the plug-in in the
downloads bar at the bottom of the browser window.

4. Enter the camera user name (default: admin) and password (default: admin) and
click Login.

@ NOTE

If video from the camera does not appear after installation, quit Chrome™ by closing the browser
window. Then restart Chrome™ and log back into your camera.
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Live View

Upon login, the web interface opens to the Live View.

(:}44,

I

CDAAA,

B

NOTE

Some functions are not available on all IP camera models, based on the features available.

1. Stream/Protocol Select: Allows you to select the video stream and protocol used in
Live View.

2. Video Display Controls (

Main Stream: Click to view the Main Stream. The Main Stream provides better
picture quality and resolution, but requires higher bandwidth.

Sub Stream: Click to view the Sub Stream. The Sub Stream is recommended for
better performance when viewing the camera over the Internet.

Protocol: Select the protocol that will be used to stream video: TCP or UDP.

PTZ

)

Original Size: Click to view the video in its original size. This depends on
the resolution and if you are viewing the Main Stream or Sub Stream.

Full Screen: Click to view the video in full screen. Double-click or press ESC
to exit full screen mode.

Width / Height Ratio: Click to select Original to use the original proportions
of the image or Adaptive to adapt the image proportions to the size of the screen.

Realtime / Fluency: Click to select Realtime, Normal, or Fluency.

@ PTZ Controls (PTZ cameras only): Click to Hide/Show PTZ camera con-

trols. For details see 5.1 PTZ Control Panel (PTZ Cameras Only)

3. Menu Tabs

Live: Click to access Live View.

PTZ: On micro PT cameras, the PTZ Control Panel is opened using the PTZ tab,
which replaces the button on the Video Display Controls panel.

Playback: Click to playback video from the camera’s microSD card (cameras that
support microSD only).

Setup: Click to setup camera functions.

Alarm: Click to configure alarms.

Logout: Log out of the camera.
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Live View

4. Live View Functions (

5.1

[ rAQ M B © I

)

. Pen: Click the pen icon to activate the pen. Then, click-and-drag to draw
lines overtop the video display. Click the arrow next to the pen icon to select the

pen color I RN

Alarm Output: Click to activate an alarm output device connected to the
camera (cameras with alarm 1/O only).

E Digital Zoom: Click to activate digital zoom mode. Click-and-drag in the vid-
eo area to select an area to zoom to, then drag to move the zoomed area or follow
motion in the video. Right-click to return to full frame view.

E ot

This control only zooms the Live View video on the current browser; other video streams are
not affected. To set a zoom level for all video streams, see 6 Setup, page 13

Snapshot: Click to save a snapshot from the camera to your computer hard
drive. To configure the folder where snapshots are saved, see 6.1.13 Path, page
28.

@ NOTE

Depending on your computer’s security settings, you may need to run your browser as adminis-
trator to save snapshots or manual recordings.

]
Triple Snapshot: Save the next three frames from the camera as snapshots.

E Manual Record: Click to start manually recording live video to your com-
puter hard drive. Click again to stop recording. To configure the folder where man-
ual recordings are saved, see 6.1.13 Path, page 28.

Audio Output: Click to mute / un-mute audio coming from the camera
(audio-enabled cameras only; must have self-powered microphone connected to
the camera).

PTZ Control Panel (PTZ Cameras Only)

From Live View, click F1Z I open the PTZ control panel.

B

NOTE

The PTZ control panel only allows you to call pre-configured function. To configure PTZ functions such
as preset locations and tours, see 6.3 PTZ, page 35
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Live View

5.1.1 PTZ Controls

PTZ Control = J

MO valid Scan

1. Click the arrows to move the camera.

2. Click the middle button to engage EZoom and then click and drag on the video to set
the camera EZoom and position.

3. Adjust the camera speed.

@ NOTE

The EZoom is an internal camera setting that will effect all video streams. Click and drag over an area
from the left to the right and the camera will zoom in and center the enclosed image. Drag from the right
to the left and the camera will zoom out and center the enclosed image.

5.1.2 Scan

You can use the Scan function to have the camera move automatically between two
points.

To configure the scan function:

1. Select Scan from the dropdown menu under PTZ Function.

PTZ Function

Scan -

2. Click Start to begin the scan.

5.1.3 Preset
You can save preset positions in the camera to recall them later.

To go to a preset location:
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Live View

1. Select Preset from the dropdown menu under PTZ Function.

2. Enter the number of the preset you would like to move the camera to.
3. Click Goto to move the camera to the preset location.

5.1.4 Pattern
You can use the pattern function to record a series of camera movements to recall later.

To run a pattern:

1. Select Pattern from the dropdown menu under PTZ Function.

2. Select the pattern to run from the dropdown menu.
3. Click Start to run the pattern.

5.1.5 Goto
The Goto function allows you to move the camera to a position with specified parameters.
To move the camera to a specified position:

1. Select Goto from the dropdown menu under PTZ Function.
PTZ Function

Goto -

Horizontal Angle(0-~360)

Vertical Angle(0~90)

EZoom{0~24)

2. Enter the Horizontal Angle you would like to move the camera to between 0~360.
3. Enter the Vertical Angle you would like to move the camera to between 0~90.
4. Enter the EZoom level between 0~24.
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Live View

5. Click Goto to go to the specified position.

5.1.6 Pan

You can use pan to have the camera move horizontally between two positions.
To start a pan:

1. Select Pan from the dropdown menu under PTZ Function.

PTZ Function

P Start

2. Click Start to begin panning.

5.1.7 Tour

Use tours to have the PTZ camera move automatically to several preset locations in a
cycle.

To start a tour:

1. Select Tour from the dropdown menu under PTZ Function.

2. Select the desired tour to run from the dropdown menu.
3. Click Start to begin the tour.
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Setup

The Setup menus allow you to configure camera settings.

6.1 Camera

The Camera tab allows you to set the camera’s thermal image processing (Settings), the
video stream parameters (Video), and the audio settings for a camera with a microphone
(Audio).

@ NOTE

For the TCX Series Mini Bullet cameras, the only camera settings available are the region of interest
(ROI), Mirror, and Flip settings. See 6.1.2 Region of Interest (ROI), page 19 for more information.

6.1.1 Settings

The Settings menu allows you to configure the image sensor’s Automatic Gain Control
(AGC) settings for the camera. As you make adjustments, the effects will be shown in the
video display.

FLIR Systems has developed three Scene Presets that contain AGC values found to pro-
vide the best overall thermal image in these different types of low or high contrast scenes.
Changes to these Scene Presets can be made using the Standard Settings and addition-
al Advanced settings , as shown below. You can save up to five Custom Scene Presets.

@ NOTE

Default values for settings of the Scene Presets can change between camera models and some cam-
era configurations.
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Setup

To configure the thermal image profile:

1. Click Low Contrast, High Contrast, or Default.

Low Contrast

High Contrast

Default

2. If needed, you can make fine-tune adjustments using the Sharpness (DDE), Gamma
(ACE), and Smart Scene Optimization (SSO) settings. Click Custom to save up to
five custom Scene Preset settings. Select Restore to set all values back to their de-

fault settings.
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Setup

E nore

Scene Preset settings are highly subjective and vary considerably depending upon scene content and
viewing or recording preferences. Individual settings may be optimized for each particular environment,
but changing conditions affecting the scene content will also affect the image quality. For more informa-
tion, technical details, or background theory regarding these settings, visit www.flir.com/.

To configure thermal image settings:

1.

Under Brightness (also known as ITT Mean, ITT Offset, or ITT Midpoint), select a
value from 0 — 100. This setting determines the temperature that is at the middle of
the 256 “shades of gray” available to the camera. Higher values allow more detail in
hotter scenes, while lower values allow more detail in lower temperature scenes.
Under Sharpness (also known as Digital Data Enhancement), select a sharpness
value between -20 to 100. Sharpness is used to enhance image details and/or sup-
press fixed pattern noise. Values above 0 increase sharpness, while values below 0
decrease sharpness. A value of 0 turns DDE off.

Under Gamma (also known as Active Contrast Enhancement), select a Gamma val-
ue from -8 to 8. Gamma provides a contrast adjustment dependent on the relative
scene temperature. Gamma values greater than 0 give more contrast to the hotter
scene content and decrease contrast for the colder scene content. Gamma values
less than 0 do the opposite by decreasing the contrast for hotter scene content and
leaving more of the “shades of gray” to represent the colder scene content.

Under EZoom, select the camera zoom factor. EZoom is continuously variable; 16
steps for 320-pixel cameras and 24 steps for 480-pixel or 640-pixel cameras. The
zoom factor is stored so that at power-up the last saved field of view is maintained.
All video streams are affected by the EZoom setting.

Under Smart Scene, select a Smart Scene Optimization (SSO) value from 0 to 100..
This value defines the percentage of the scene that will be allotted a linear mapping.
With SSO enabled, the difference in gray shades between two objects is more repre-
sentative of the difference in temperature, although the optimization in local contrast
can be lost.
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6. Under Colorization, select one of the available colorization palettes. The thermal
camera image usually contains 256 “shades of gray” representing different tempera-
tures present in a scene. The colorization palettes provide the ability to add color to
the camera image through the use of Look Up Tables (LUT) that map the 256 temper-
ature groupings to colors. Some examples of different LUTs are shown below. Addi-
tional LUTs are sometimes added during the firmware update cycle, so you may have
LUT options that are not described here.

* Select the White Hot palette to make hot objects appear “white” or brighter than
colder objects.

* Select the Black Hot palette to make hot objects appear “black” or darker than
colder objects.

* Select Ironbow? palette ranges from blue (coldest) through red, orange, and
white (hottest).
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* Select the IceFire palette to use the same palette as the White Hot palette except
coldest temperatures are blue and the hottest temperatures are red.

7. Under Mirror, select ON to flip the camera image left and right.
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8. Under Flip, select one of the options to flip the image. This setting is useful if the

camera’s lens module was rotated during installation to provide a better view down a

long corridor or hallway.
Mini-Bullet Settings Menu:

E nore

The Mirror and Flip settings are only available on fixed bullet cameras.

Advanced Thermal Image Settings

The AGC plateau equalization algorithm performs a non-linear transformation from a 14—

bit image to an 8-bit image limiting the maximum number of shades of gray devoted to
any particular portion of the scene.
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AGC Filter (0 to 255)

The AGC filter is used to adjust how quickly the AGC algorithm reacts to a change in a
scene. If the AGC filter is set to a low value, when a hot object enters the field of view,
the AGC will adjust more slowly, resulting in a gradual transition. A setting of 255 causes
an immediate update, a setting of 1 causes the slowest update, and a setting of 0 indi-
cates no updates to AGC.

AGC Max Gain (0 to 255)

For scenes with high dynamic range (a wide 14-bit histogram), the maximum gain pa-
rameter has little effect. For a very bland scene ( a narrow 14-bit histogram), a higher
setting of AGC Max Gain will significantly increase the contrast of the resulting image.

AGC Plateau (0 to 255)

When the AGC Plateau value is set to a high value, more shades of gray are mapped to
areas of similar temperature. When the AGC Plateau level value is set to a low value, the
mapping is more linear. For example, an image comprised of 60% sky (very cold) will de-
vote 60% of the available shades to the sky, leaving only 40% for the remainder of the
image.

FFC

Click FFC to manually initiate a flat field correction (FFC), updating the pixel calibration
to improve the image quality. The FFC is also performed automatically during changes in
temperature.

6.1.2 Region of Interest (ROI)

Use the thermal region of interest (ROI) to select only the portion of the scene that the
automatic gain control (AGC) will use to optimize the image. The region is automatically
adjusted for zoom. You can select a preset ROI or create a custom ROI. The custom ROI
Type provides the ability to setup a rectangular region of any size and move it to any lo-
cation in the image.

To set up a custom ROI region:

1. Under ROI Type, select Custom.
2. Click and drag a corner of the yellow box to resize the ROI region.
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3. Click and drag the box to adjust the location of the ROI region.

6.1.3 Setting ROI to Match Motion Detection Areas

After configuring motion detection areas, you can set up the ROI to include all motion de-
tection areas.

To set ROI to match motion detection areas:

1. Set up motion detection areas. For more details, see 6.4.1 Motion Detect, page 38.
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2. Click Camera>Settings to display the camera settings menu.
3. Under ROI Type, select Custom. ROI will automatically be set to include all motion
areas.

Multiple motion detection areas will result in a single ROI.

6.1.4 Video

The Video tab allows you to configure the encoding settings for the camera. Video set-
tings are divided into Main Stream and Sub Stream.

To configure video quality settings:

1. Check Enable under Sub Stream to enable the sub stream or uncheck to disable.
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3.

4.
5.

For the Main Stream and Sub Stream, configure the following:

¢ Code Stream Type: For the Main Stream, select Continuous to configure set-
tings when motion is not detected, Motion to configure settings when motion is
detected, or Alarm to configure settings when an alarm is detected.

* Encode Mode: Select the encoding type: H.264 (Main H.264 profile), H.264H
(High Profile H.264), H.264B (Baseline H.264 profile), MJPEG.

E ot

It is recommended to use H.264 unless you have special requirements.

A much higher bitrate and faster connection is required to maintain image quality using MJPEG.

* Resolution: Select the desired resolution for the video stream. SXGA (1280 x
1024) provides full data from PTZ and Bullet cameras, while 720p (1280 x 720)

crops the top and bottom of the image to fit the video resolution. There is a differ-

ent recommended bit rate depending on the resolution selected.

@ NOTE

720p (1280x720) crops the top and bottom of the image to fit the video resolution.

* Frame Rate (FPS): Select the desired frame rate for the video stream between 1

and 30 FPS.

¢ Bit Rate Type: Select CBR (Constant Bit Rate) or VBR (Variable Bit Rate). If you

select VBR, you can select the Video Quality between 1 (lowest) and 6 (best).

* Reference Bit Rate: Recommended bit rate range based on the resolution and

frame rate settings you have selected.

¢ Bit Rate: Select the desired bit rate for each video stream or select Customized

and enter the bit rate in Kbps.
¢ | Frame: Select the interval for | frames (30~150 for NTSC, 25~150 for PAL).

Under Watermark Settings, check to enable watermark to protect against video
tampering.

Under Watermark Character, enter the desired watermark text.

Click Save to save changes.

6.1.5 Snapshot

The Snapshot menu allows you to configure images quality settings for snapshots.

To configure snapshots:

1.

Configure the following:

* Snapshot Type: Select Scheduled to configure snapshots taken using sched-

uled recording. Select Event to configure snapshots activated by alarms.

* Image Size: The image size of snapshots is the same as the resolution for the
stream selected.

* Quality: Select the image quality for snapshots between 1 (lowest) and 6
(highest).

* Interval: Select the interval between snapshots between 1 and 7 seconds. Select

Customized to select an interval from 1~50000 seconds.
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2. Click Save to save changes.

6.1.6 Overlay

The Overlay tab allows you to configure the text and information that appears overtop of
the camera image, such as time and date display. Click Enable or Disable for each of the
sub tabs described below on the Overlay tab. Click Save to save changes.

To configure video overlay:

1. Under Channel Title, click Enable to show the name of the channel on screen.
Under Input channel title, enter a personalized channel name. Click and drag the
Channel Title box to any location on the screen. Click Save to save changes.

2. Under Time Title, click Enable to show the time. Check Week Display to show the
time and day of the week. Click Save to save changes.
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3. Under Text Overlay or OSD info (PTZ), click Enable to display the Input Text and
enter a custom message.

PTZ Camera Only:

Click Enable for Preset to briefly show on screen the Preset name or number when
activated. Click Enable for Coordinates to show the pan (P) and tilt (T) angles of the
camera on screen.

4. Under Picture Overlay, click Upload to select and upload an image. Move the green
overlay box to the desired location in the video frame. Click Enable to display the up-
loaded bitmap image, and then click Save to save changes.

6.1.7 Privacy Masking

Configure privacy masks to hide certain parts of the camera image in video recordings
(Not available on the PTZ camera).
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/\  cAuTION

Privacy masks block out parts of the camera image entirely and appear as black boxes in recordings.

To configure video overlay:
1. Under Privacy Masking, you can create up to four privacy masks.

* Click the corners of a privacy area to adjust the size of the privacy area.
* Right-click to delete the currently selected privacy area.
* Click-and-drag outside of the privacy areas to create a new privacy area.
* Click Save to save changes.

6.1.8 PTZ Speed

Set the speed for the camera’s Pan-Tilt-Zoom functions.

To set PTZ speed:

1. Under PTZ > Function, click PTZ Speed.

2. Click either Low, Middle, or High to set the speed of PTZ functions
6.1.9 Idle Motion

You can set the camera to perform a certain action when it is left idle for a set period of
time.
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To configure idle motion:

—_

Under PTZ > Function, click Idle Motion.

Check Enable to enable the idle motion feature.

3. Select an idle motion for the camera. You can choose from Preset, Tour, Scan, or
Pattern.

@ NOTE

You must setup at least one of the corresponding functions to set it as the idle motion. For example,
you must setup at least one tour to select Tour as the Idle Motion.

N

4. Under Idle Time, set the time in minutes before the idle camera performs the set idle
motion.
5. Press the Save button to save your selection.

6.1.10 Power Up

Choose an action for the PTZ camera to perform when it first powers up.
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To configure the power up function:

—_

Under PTZ > Function, click PowerUp.

2. Check Enable to enable the power up feature.

3. Select a power up function for the camera. You can choose from Preset, Tour, Scan,
Pattern, or select Auto to perform the default PTZ diagnostic check on startup.

@ NOTE

For all options except Auto, you must setup at least one of the corresponding functions to set it as
the power up function. For example, you must setup at least one tour to select Tour as the power
up function.

4. Click Save to save your settings.

6.1.11 PTZ Restart

Restart the PTZ camera.

To restart the PTZ camera:

1. Under PTZ > Function, click PTZ Restart.
2. Click PTZ Restart.

6.1.12 Default
Set all PTZ functions back to the default settings.

/\  cAuTioN

Resetting to defaults will erase any custom PTZ functions you have created — this step cannot be
undone.
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To reset PTZ defaults:

1. Under PTZ > Function, click Default.
2. Click the Default button. You will be prompted to confirm the reset.

/I CAuTION

Resetting to defaults will eras any custom PTZ functions you have created — this step cannot be
undone.

6.1.13 Path

The Path tab allows you to configure the folder where snapshots and manual recordings
are saved to.

To configure the recording and snapshot folder:

1. Configure the following:

Live Snapshot: The folder on your hard drive where snapshots are stored. Click
Browse to select a different folder.

Live Record: The folder on your hard drive where manual recordings are stored.
Click Browse to select a different folder.

Playback Snapshot: The folder on your hard drive where playback snapshots
are stored. Click Browse to select a different folder.

Playback Download: The folder on your hard drive where playback downloads
are stored. Click Browse to select a different folder.

Video Clips: The folder on your hard drive where video clips are stored. Click
Browse to select a different folder.

E ot

An SD / microSD card (not included) must be installed to use playback functions. Check the techni-
cal specifications for your camera to see it supports SD / microSD cards.

2. Click Save to save changes.
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6.1.14 Audio

The Audio tab allows you to enable / disable camera audio as well as choose the audio

encoding type. The settings in this menu will affect both one-directional and bidirectional
audio for the camera.

E ot

This setting is only available on cameras with a microphone. Check the technical specifications for your
camera.

To configure audio settings:

Check Enable under Main Stream, Sub Stream, or both to enable audio.
Under Encode Mode, select an encoding mode from PCM, G.711A and G.711Mu.
Click Save to save changes.

Under Attributes, configure settings and set microphone and speaker volume levels.

PN~

5. Click Save to save changes.
6.2 Network

6.2.1 TCP-IP

The TCP-IP menu allows you to configure the camera for DHCP or Static IP addressing.
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To configure IP address settings:

'y

Under Host Name, enter the Host Name for the camera up to 32 characters.

Under IP Version, select IPV4 or IPV6.

3. Under Mode, select Static or DHCP. If you select Static, configure the IP Address,
Subnet, Mask, Default Gateway, Preferred DNS Server, and Alternate DNS
Server.

4. Click Save to save changes.

o

6.2.2 Connection

The Connection menu allows you to configure the camera ports and maximum connec-
tions to the camera. You must port forward the HTTP (default: 80) and TCP (default:
35000) port numbers on your router to enable remote connection to your camera.

@ NOTE

If you are not using an NVR and are setting up multiple cameras in the same network for remote access,
you must assign unique TCP and HTTP ports for each camera. Two cameras cannot share the same
port number.

To configure connection settings and ports:

1. Under Max Connection, enter the maximum number of devices that can connect to
the camera at the same time between 1 and 20.
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4.

5.

Configure the following port settings:

e TCP Port: Enter the TCP (Client) Port number (default: 35000). The TCP port is
used to stream video to remote computers or mobile devices. The TCP Port must
be port forwarded to enable remote connection to your camera.

e UDP Port: Enter the UDP Port number (default: 37778). The UDP Port is used for
special applications only.

e HTTP Port: Enter the HTTP Port (default: 80). The HTTP Port is used to access
the camera’s web interface. The HTTP Port must be port forwarded to enable re-
mote access.

@ NOTE

If you change the HTTP Port to anything other than 80, you must enter colon (:) and the HTTP
port in your web browser to access the camera (e.g. http:/tomsmith.myddns-flir.com:85).

¢ RTSP Port: Enter the RTSP Port (default: 554). The RTSP Port is used for special
applications. For details on RTSP streaming, see 12 RTSP Streaming (Advanced),
page 135.

(Optional) To enable HTTPS, check HTTPs On. To connect to the camera using
HTTPS, you must forward the HTTPS port (default: 443) on your router. You must al-
so connect to the camera using the following format:

e https://IP or DDNS address: HTTPS Port
* For example: https://tomsmith.myddns-flir.com:443

(Optional) To configure the HTTPS port, enter the custom port number under HTTPS
Port (default: 443).
Click Save to save changes.

6.2.3 ONVIF

The camera supports ONVIF Profile S v2.4. You can enable or disable ONVIF authenti-
cation under Network>Connection>ONVIF.

6.2.4 PPPoE

The PPPoE menu allows you to enter a PPPoE user name and password (usually pro-
vided by a DSL provider).
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To configure PPPoE:

pPOD

Click Enable.

Under Username, enter the PPPoE user name.
Under Password, enter the PPPoE password.
Click Save to save your changes.

6.2.5 DDNS

The DDNS menu allows you to set up the camera with a free FLIR DDNS account for re-
mote connectivity. You can register for a FLIR DDNS account at ddns.myddns-flir.com.

To configure DDNS:

1.
2.

3.

P

Under Server Type, check the checkbox and select FlirDDNS.

Under Domain Name, enter the Domain Name from the confirmation email you re-
ceived after registering for DDNS.

Under Username, enter the User Name from the confirmation email.

Under Password, enter the Password from the confirmation email.

Click Save.

@ NOTE

It may take between 10~15 minutes for the DDNS server to update with your new DDNS address.

6.2.6 IP Filter

The IP Filter allows you to create a white list of device MAC or IP addresses that can ac-
cess the camera. If you use the IP filter menu, devices that are not on the white list will
not be able to remotely connect to the camera.
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@ NOTE

If you enable the IP filter the camera will block any device that is not listed. Make sure the correct devi-
ces are added to the list, or you may not be able to access the camera.

To filter connections based on IP or MAC addresses:

1. Click Add IP/MAC.
2. Select IP Address or MAC Address and then enter the address of the device you
would like to add to the white list.

3. Click Save.
4. Check Trusted Sites.
5. Click Save to save changes.

6.2.7 SMTP (Email)

The SMTP menu allows you to set up email alerts for motion or alarms.
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To configure SMTP Settings:

1. Co

nfigure the following:

SMTP Server: Enter the SMTP server address.

Port: Enter the Port used by the server.

Anonymity: Check if the server allows anonymous logins or uncheck to enter cre-
dentials to access the server.

Username: Enter the user name of the sender’s account.

Password: Enter the password of the sender’s account.

Sender: Enter the sender’s email account.

Authentication: Select SSL or TLS.

Mail Receiver: Enter the email address that will receive email alerts.

Interval: Select the interval for sending email alerts. The system will only send
email alerts after this interval has passed.

Health Mail: Check to enable the camera to send health alerts. If you enable
health alerts, enter the interval in seconds under Update Period.

2. Click Email Test to send a test email using the settings you have entered.
3. Click Save to save changes.

6.2.8

UPnP

UPnP allows you to map port numbers between the LAN and the Internet. Depending on
your router version, you may need to disable UPnP function.

6.2.9

Bonjour (unsupported)

6.2.10 Multicast (Advanced)

When
tion to
set.

there are multiple hosts receiving the same data packets, multicast is the best op-
reduce the bandwidth and the CPU load. The source host can send out one data
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To enable multicast:

1.

2.

Under Main Stream or Sub Stream, click Enable. The main stream and sub stream
are enabled by default.
Under Multicast Address, enter the desired multicast IP address.

E norme

If there are multiple cameras using multicast on the same network, each camera must have a differ-
ent multicast IP address. Multicast addresses must be between 224.1.2.4 and 239.255.255.255.
For example, 239.255.42.42

Under Port, enter your desired port for main stream, such as 40000 for main stream
and 40006 for the sub stream. Main and sub stream should have different ports if
multicast IP is the same.

@ NOTE

Multicast port numbers must an even number between 1025 and 65529.

Use the following URL to retrieve the video:

rtsp.://<IP Address>/cam/realmonitor?channel=1&subtype=<0 for main stream or 1 for

substream>&unicast=false

For example, if the camera has the IP address 192.168.250.226, and multicast da-
ta as above, use:

Main Stream:
rtsp://192.168.250.226/cam/realmonitor?channel=1&subtype=0&unicast=false

Sub Stream:
rtsp://192.168.250.226/cam/realmonitor?channel=1&subtype=1&unicast=false

6.2.11 QoS (Service Only)

6.3 PTZ

The PTZ submenu allows you to configure preset locations, patterns, and tours for re-
trieval at any time.

6.3.1 Preset

Presets wills save a camera position for quick retrieval.

To add presets:

1.
2.
3.

Under PTZ > Function, click Preset.
Use the PTZ controls to move the camera to the desired location.
Click Add to add the current location to the list of presets.
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4. Double-click on the Preset Title to enter a descriptive title which will be displayed on

the Live Page.

Set the Preset Image and Preset Video Motion Detection settings. These settings
can be unique to each Preset#.

Click Save. You can now call the preset location from the Live View tab using the
PTZ control panel.

To delete presets:

* Click E] next to the preset title you want to delete to remove it from the list.

To take a snapshot:

¢ Click D to take a snapshot of the current preset location.

6.3.2 Tour

Tours will cycle through a set of presets.

To add a tour:

PON

Under PTZ > Function, click Tour.

Click Add beneath the tour list to add a new tour.

(Optional) Double-click the tour name to enter a personalized name for the tour.
Click Add beneath the preset list to add a location to the tour. By default, the newly
added location will show the number “1” under the Preset column.

Double-click the number “1” under Preset to open a dropdown menu with all of your
saved preset locations. Select the preset number you want to use as the first location
in the tour.

Repeat steps 4 & 5 for as many preset locations you would like in the tour. When fin-
ished, press Save to save the tour.

You can press the Start button to test the tour, then Stop to stop the test.
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To delete a tour:

e Click :_] next to the tour you want to delete to remove it from the list.

6.3.3 Scan

An auto scan automatically cycles between a set left and right limit.

To add a scan cycle:

—_

6.

7.

Under PTZ > Function, click Scan.
Under Scan No., select the scan cycle you would like to configure.
Click Set to open the Set Limits buttons.

@ NOTE

Setting the left limit also sets the elevation level of the scan. Manually scan the area you wish to in-
clude to select the best elevation for the entire area, then select the left limit.

Using the PTZ controls, move the camera to the leftmost point of the scan pattern
you want to set and click Set Left Limit.

Move the camera to the rightmost point of the scan pattern you want to set and click
Set Right Limit.

Under Speed, click / + or use the slider to set the speed of the scan cycle. Setting a
higher number means the camera will move faster between the left and right limits.
Press the Start button to test the scan cycle, then Stop to stop the test.

6.3.4 Pattern

You can set the pattern function to record a series of camera movements to recall later.

To save a pattern:

1.
2.

Under PTZ > Function, click Pattern.
Under Pattern No., select the pattern cycle you would like to configure.
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3. Click Set.

4. Press Start Record to start recording a pattern. Move the camera in the desired pat-
tern using the PTZ controls. When finished, press Stop Record

5. Press Set again to save the pattern.

6. Press the Start button to test the pattern, then Stop to stop the test.

6.3.5 Pan

Set the camera to pan continuously at a set speed.

To setup auto-pan:

1. Under PTZ > Function, click Pan.
2. Under Pan Speed, click /+ or use the slider to set the panning speed.
3. Press the Start button to test the auto-pan, the Stop to stop the test.

6.4 Event

6.4.1 Motion Detect

The Video Detect menu allows you to set up motion detection and recording.

@ NOTE

Recording functions require an FTP server or an on-board microSD card. Some camera models do not
support these recording features.

To set up motion detection settings:

1. Check Enable to enable motion detection.
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2. To configure a schedule when motion detection will be activated, click Setup next to
Working Period.

¢ Select the day you would like to configure by clicking the Setup buttons. You can
apply the same schedule to multiple days using the checkboxes.

* Configure up to 6 time periods when motion detection will be activated.

¢ Click Save. Repeat the steps above if you would like to apply a different schedule
to different days.

3. Under Anti-dither, enter the anti-dither time. After a motion event occurs and motion
stops, if motion is detected within the anti-dither time, the system continues the mo-
tion event and includes the new motion within the first event, rather than creating a
new motion event.
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10.

11.

12.

To configure the motion grid, click Setup next to Area.

¢ Click squares on the grid to create motion detection areas. Click on the different
colors to set 4 different areas.

* To move an area, click inside and drag.

¢ Right-click to delete the selected area.

¢ Click-and-drag outside of all areas to draw a new area. You may have up to 4 mo-
tion areas.

* Use the sliders to adjust the Sensitivity and Threshold for motion detection.

/I\  cAuTION

Itis recommended to have someone moving in areas of interest on the camera image during
setup.

o The Sensitivity determines how sensitive the camera is to motion. For exam-
ple, if the sensitivity is high, small amounts of motion will score higher on the
graph. It is recommended to select a Sensitivity between 30~70.

o The Threshold determines how much motion is required to trigger an alarm or
recording. It is represented by the horizontal line on the graph. If the amount of
motion in the area exceeds this line, it will trigger an alert. It is recommended to
select a Threshold between 10~50.

o Each motion area can have a separate Sensitivity and Threshold value.

o Click Save.

Check Record to record when motion is detected. microSD or FTP recording must
be configured to use this function.

Enter the number of seconds the camera will record after motion is detected under
Post Record.

Check Relay Out to trigger an external alarm device when the camera detects mo-
tion. The camera must have an Alarm Output to use this function.

Enter the number of seconds before the camera will trigger the external device under
Alarm Delay.

Check Send Email for the camera to send an email alert when motion is detected.
Email settings must be configured to receive email alerts.

Check PTZ to select a Preset, Tour, or Pattern that the camera (PTZ camera only)
will perform when motion is detected. The selected action must have previously been
configured. To configure PTZ actions, see 6.3 PTZ, page 35

Check Snapshot for the camera to save a snapshot when motion is detected. mi-
croSD or FTP recording must be configured to use this function.

Click Save to save changes.

6.4.2 Relay Activation (Cameras with Alarm I/O Only)

The Alarm menu allows you to configure settings for alarm devices. Your camera must
have an alarm I/O connector to use alarm devices.
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To configure alarm device settings:

1. Configure the following:

Under Relay-In, select the alarm device you would like to configure.

Check Enable to enable the selected alarm input device.

Click Setup next to Working Period to set a schedule for alarm device activation.
Under Anti-Dither, enter the latch time in seconds.

Under Sensor Type, select NO (Normally Open) or NC (Normally Closed) de-
pending on the type of sensor used.

Check Record to record when a sensor device is triggered.

Under Post Record, enter the amount of time the system will record when a sen-
sor device is triggered.

Check Relay-out to activate an alarm output device (e.g. strobe light) when the
sensor device is triggered. The camera must have an alarm output to use this fea-
ture. Enter the number of seconds before the camera will trigger the external de-
vice under Alarm Delay.

Check Send Email for the camera to send out an alert email when the sensor de-
vice is triggered.

Check PTZ to select a Preset, Tour, or Pattern (or None) that the camera (PTZ
camera only) will perform when an alarm occurs. The selected action must have
been previously configured. To configure PTZ actions, see 6.3 PTZ, page 35.
Check Snapshot for the camera to save a snapshot to FTP or microSD when the
sensor device is triggered.

2. Click Save to save changes.

6.4.3

System Alerts

System Alerts include notifications for SD Card, Network, and lllegal Access issues.
Each event can be configured independently.

B

NOTE

The N
techni

o SD Card warning is only available on cameras that support SD / microSD cards. Check the
cal specifications for your camera.
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To configure No SD Card errors:

1.
2.
3.

4.
5.

Under Event Type, select No SD Card.

Check Enable to enable No SD Card errors.

Check Relay-out to trigger an alarm out device when No SD Card errors occur.
Under Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

@ NOTE

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

Check Send Email to send an email alert when No SD Card errors occur.
Click Save to save changes.

To configure Capacity Warnings:

A Capacity Warning occurs when the recording destination (microSD / SD card or FTP
server) reaches capacity.

To configure Capacity Warnings:

—_

Under Event Type, select Capacity Warning.

Check Enable to enable Capacity Warnings.

Under Capacity Limit, set the percentage of free space on the recording destination
that will trigger a Capacity Warning. For example, if you enter 10% and your microSD
card is 1GB, a warning will occur when there is only 100MB of free space remaining.
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5.
6.

Check Relay-out to trigger an alarm out device when Capacity Warnings occur.
Under Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

E nore

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

Check Send Email to send an email alert when Capacity Warnings occur.
Click Save to save changes.

To configure SD Card Errors:

An SD Card Error occurs if an error occurs recording to the SD / microSD card (for exam-
ple, if the card is damaged or is using the wrong file system).

@ NOTE

The SD Card Error warning is only available on cameras that support SD / microSD cards. Check the
technical specifications for your camera.

To configure SD Card Errors:

—_

4.
5.

Under Event Type, select SD Card Error.

Check Enable to enable SD Card Errors.

Check Relay-out to trigger an alarm out device when SD Card Errors occur. Under
Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

@ NOTE

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

Check Send Email to send an email alert when SD Card Errors occur.
Click Save to save changes.

To configure Disconnection errors:

A Disconnection error occurs if the camera is disconnected from the network.
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To configure Disconnection Errors:

'y

5.
6.

Check Enable to enable Disconnection errors.
Check Record to record to the microSD / SD card when Disconnection errors occur.

E nore

The camera must support microSD / SD card recording to use this function. Check the technical
specifications for your camera.

Under Post Record, enter the number of seconds the camera will record after a Dis-
connection error.

Check Relay-out to trigger an alarm out device when Disconnection errors occur.
Under Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

@ NOTE

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

Check Send Email to send an email alert when Disconnection errors occur.
Click Save to save changes.

To configure IP Conflict errors:

An IP Conflict error occurs if another device is assigned the same IP address as the IP
camera.

To configure IP Conflict errors:

1.
2.

Under Event Type, select IP Conflict.
Check Enable to enable IP Conflict errors.
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6.
7.

Check Record to record to the microSD / SD card when IP Conflict errors occur.

@ NOTE

The camera must support microSD / SD card recording to use this function. Check the technical
specifications for your camera.

Under Post Record, enter the number of seconds the camera will record after an IP
Conflict

Check Relay-out to trigger an alarm out device when IP Conflict errors occur. Under
Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

E nore

Relay-out is only available if your camera supports alarm output. Check the technical specifications
for your camera.

Check Send Email to send an email alert when IP Conflict errors occur.
Click Save to save changes.

6.4.4 Network

Some cameras group the IP Conflict and Disconnection warnings into a single Network
warning tab.

To enable IP Conflict / Disconnection errors:

1.
2.

Under Event Type, select Disconnection or IP Conflict.
Check Enable to enable the selected warning type.

6.4.5 lllegal Access

Set the camera to trigger an alarm (if supported) or send an email when the username or
password is incorrectly entered multiple times to access the camera.
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To enable lllegal Access errors:

—_

4.
5.

Check Enable to enable the lllegal Access warning.

Under Login Error, enter the number of times that wrong username / password can
be entered before the warning is triggered.

Check Relay-out to trigger an alarm out device when IP Conflict errors occur. Under
Alarm Delay, enter the number of seconds before the alarm out device will be
activated.

B nore

Relay-out is only available if your camera supports alarm output.

Check Send Email to send an email alert when IP Conflict errors occur.
Click Save to save changes.

6.5 Storage

The Storage menu allows you to configure recording settings.

6.5.1 Record Schedule

The Record Schedule determines the schedule for video recording to SD / microSD card
or FTPR.

To configure the recording schedule:

1.
2.
3.

Click Setup next to the day you would like to configure.

Use the checkboxes if you want to copy the schedule to other days.

Configure up to 6 time periods for recording. For each period, enter a time range and
check the recording types you would like to enable during that period:

¢ Continuous: Continuous recording.
* Motion: Motion activated recording.
e Alarm: Alarm activated recording.

Setup

| el Sunday [ Monday Wedne ay ature Holiday

Period 1 = : . inous Mation

Period 2 = . . B Continous [l Motion

Period 3 = : . W continous [M Motion

Period 4: = : . W continous [ Motion [ Alarm

Period 5 = : . W Continous [ Motion [ Alarm

Period 6 - : : W continous [ Moton W Alarm

Save Cancel

3.1.  Check to copy schedule
3.2.  Configure up to 6 periods
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3.3.  Enable recording types
4. Click Save.

6.5.2 Snapshot Schedule

The Snapshot schedule determines the schedule for snapshot recording.

To configure the snapshot schedule:

1. Click Setup next to the day you would like to configure.

2. Use the checkboxes if you want to copy the schedule to other days.

3. Configure up to 6 time periods for recording. For each period, enter a time range and
check the recording types you would like to enable during that period:

e Continuous: Continuous recording.
* Motion: Motion activated recording.
e Alarm: Alarm activated recording.

Setup

W Al W Sunday M Monday M We y W Thursday M Friday [ S

Period 1 = : : Contin Mation Alarm

Period 2 = . . W Contin Mation

Period 3 = : . W Contin Motion [l Alarm

Period 4: = : . W Contin Motion [l Alarm

Period 5 = : : W Contin Motion

Period 6 = : : W Continous M Motion [ Alarm

Save Cancel

3.1.  Check to copy schedule
3.2.  Configure up to 6 periods
3.3.  Enable recording types

4. Click Save.

@ NOTE

Alternatively, you can click and drag over days and times to determine the schedule for snapshot
recording.
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6.5.3 Holiday Schedule

The Holiday Schedule allows you to set certain days of the year as holidays.

To configure the holiday schedule:

1. Check Record or Snapshot to enable holidays for that recording type.
2. Use the calendar to select which days are holidays.
3. Click Save.

6.5.4 Path

The Path tab allows you to select if the camera records to microSD or FTP.

To select the recording destination:

1. Under Record or Snapshot, check Local to record to the microSD card, check FTP
to record to FTP, check NFS to record using network file system protocol or check
SMB to record using Server Message Block. For video recording or for taking snap-
shots, only one option can be selected.

2. Click Save.
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6.5.5 Local

@ NOTE

Local storage is only available when the camera has an installed microSD card.

The Local tab allows you to format or configure the microSD card installed in the camera.

Click Read Only to set the microSD card on read only mode. This disables microSD
recording.

Click Read & Write to enable recording on the microSD card.

Click Hot Swap to unmount the microSD card if you would like to eject it from the
camera.

Click Format and then click Yes to format the microSD card. The camera will reboot
once the format is completed.

6.5.6 FTP

The FTP tab allows you to set up settings for recording to an FTP server.

To set up FTP settings:

—_

Check Enable to enable recording to FTP.

2. Configure the following:
e Server Address: Enter the IP address or DNS address of the FTP server.
e Port: Enter the FTP server port number.
¢ User Name: Enter the user name for the FTP server.
e Password: Enter the password for the FTP server.
¢ Remote directory: Enter the recording directory on the FTP server (e.g. share).
E ot
The recording directory must be located one level below the root directory. For example, share
is acceptable, but not share/recordings.
¢ Check Emergency (Local) to enable microSD recording if the FTP server cannot
be reached.
3. Click Save to save changes.
6.5.7 NFS

The NFS tab allows you to configure recordings to a NFS (network file system).
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To set up NFS settings:

1. Check Enable to enable recording to NFS.
2. Configure the following:

¢ Server Address: Enter the IP address or DNS address of the NFS.
* Remote directory: Enter the recording directory on the NFS (e.g. share).

E ot

The recording directory must be located one level below the root directory. For example, share
is acceptable, but not share/recordings.

3. Click Save to save changes.

6.5.8 SMB

The SMB tab allows you to configure settings for recording using a server message
block.

To set up SMB settings:

—_

Check Enable to enable recording using SMB.
2. Configure the following:

e Server Address: Enter the IP address or DNS address of the SMB server.

¢ Port: Enter the SMB server port number.

¢ User Name: Enter the user name for the SMB server.

¢ Password: Enter the password for the SMB server.

* Remote directory: Enter the recording directory on the SMB server (e.g. share).

3. Click Save to save changes.

@ NOTE

The recording directory must be located one level below the root directory. For example, share is ac-
ceptable but not share/recordings.

6.5.9 Record Control

The Record Control menu allows you to configure recording parameters for the camera.
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To configure recording parameters:

1. Under Pack Duration, enter the duration in minutes that the camera will use to pack
video.

2. Under Pre-event Record, enter the duration in seconds that the camera will pre-re-
cord before motion events.

3. Under Disk Full, select Overwrite to overwrite recordings when the recording me-
dium is full or select Stop to stop recording when the recording medium is full.

¢ Under Record Mode, select Auto to record according to the schedule, select
Manual to record continuously, or select Off to disable recording.

4. Under Record Stream, select Main Stream to record using the Main Stream set-
tings, or select Substream to record the substream.
5. Click Save to save changes.

6.6 System

6.6.1 General

The General menu allows you to configure general camera settings.

To configure general camera settings:

1. Under Device Name, enter a name for the camera.

2. Under Language, select the language that will be used for the web browser interface.
3. Under Video Standard, select NTSC (North America) or PAL (Europe).

4. Click Save.

6.6.2 Date & Time

The Date & Time tab allows you to set up date and time settings for the IP camera.
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To configure date & time settings:
1. Configure the following:

¢ Date Format: Select the date format.

¢ Time Format: Select the time format (12 hour or 24 hour).

¢ Time Zone: Select your time zone.

e Current Time: Enter the current time or click Sync PC to sync your IP camera to
your PC’s clock.

2. If your area uses Daylight Savings Time (DST) check DST Enable. If you enable
DST, configure the following:

* DST Type: Select Date to select a date for the time change or select Week to se-
lect the week and day for the time change.
¢ Start Time and End Time: Enter the start and end times for Daylight Savings.

3. Check Synchronize with NTP to synchronize the camera clock with an NTP time
server. A constant Internet connection is required to use NTP. If you enable NTP, con-
figure the following:

* NTP Server: Enter the NTP server address.
¢ Port: Enter the port for the NTP server.
e Update Period: Enter the interval the camera will use to update the time.

4. Click Save.

6.6.3 Account

The Account menu allows you to configure user accounts and user groups. The camera
can support up to 18 user accounts and up to 8 groups. User accounts must be assigned
to a group and inherit permissions from user groups, but an individual user account can
be given less permissions than the group.

The camera includes a unique admin account that cannot be deleted. The admin ac-
count is the only one that can change permissions assigned to user accounts. Accounts
given permission to access the Account menu may change the password for other ac-
counts. Accounts not given permission to access the Account menu may not change any
account passwords, including their own. It is essential to change the password of the ad-
min account from the default to prevent unauthorized access to your camera.

You may also check Anonymous Login to allow users to connect to the camera without
entering a user name or password. Users connecting anonymously are given limited ac-
cess to the camera: they may only view live video and the Alarm list.
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To create a user account:

1. Click Add User.
2. Configure the following:

2.1. User Name: Enter a user name for the user. The user name can be up to 15
characters including letters, numbers, and underscores.

2.2. Password: Enter a password for the user account. Re-enter the password
under Confirm Password.

2.3.  Group: Assign the user account to a group. The user account will inherit per-
missions from the group, which will be updated under Authority List.

2.4. Remark: (Optional) Enter a description for the user account.

2.5. Authority List: Use the checkboxes to assign permissions to the user
account.

3. Click Save.

To create a user group:
1. Click the Group tab.
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2. Click Add Group.

3. Configure the following:

3.1.  Group: Enter a name for the group.

3.2.  Remark: (Optional) Enter a description for the group.

3.3.  Authority List: Use the checkboxes to assign the default permissions for user
accounts added to this group.

4. Click Save.
To modify a user account or group:

1. Select the User or Group tab.

2. Click next to the account or group you would like to modify.
3. Edit the account or group details and then click Save.
To delete a user account or group:

1. Select the User or Group tab.

2. Click E] next to the account or group you would like to delete.
3. Click OK.

6.6.4 Default

Click Default and then click OK to reset the camera to default settings. Network settings
will remain unchanged. The camera will reboot.

OR

Click Reset System and then click OK to reset the camera to factory default settings, in-
cluding network setting.
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6.6.5 Import/Export

The Import/Export menu allows you to export your camera’s configuration or import a
saved configuration.

To export the camera’s configuration:

1. Click Export.
2. Select a location on your computer and then click Save.

To import the camera’s configuration:

1. Click Import.
2. Select the configuration file you would like to backup and then click Open.

6.6.6 Auto Maintain

The Auto Maintain menu allows you to reboot the camera manually or on a automatic
schedule. It also allows you to automatically delete old video files.

To manually reboot the camera:
¢ Click Manual Reboot and then click OK to reboot the camera.
To configure auto reboot:

1. Check Auto Reboot to set the camera to reboot automatically on schedule.
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2. Select the day and time for the camera to reboot.

3. Click Save.
To configure auto delete:

1. Check Auto Delete Old Files.
2. Enter the number of days the camera will retain video files.
3. Click Save.

6.6.7 Upgrade

The Upgrade menu allows you to upgrade the camera firmware. When firmware up-
grades are released, they are available for free from www.flirsecurity.com/pro.

To upgrade the camera firmware:

Download and extract the firmware from www.flirsecurity.com/pro.
Click Browse.

Select the firmware file on your computer and then click Open.

Click Upgrade. The camera will upgrade the firmware and then reboot.

PN~

6.7 Information

6.7.1 Version

The Version menu shows you information related to the product and firmware version.
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6.7.2 Log

The Log menu allows you to view system logs for the camera.

To view system logs:

1. Under Start Time and End Time, enter the start time and end time for your search.

2. Under Type, select the type of log you would like to search for: All, Setting, Data,
Event, Record, Account, and Clear Log.
3. Click Search.

¢ (Optional) Click Backup to save logs to your computer hard drive.
¢ (Optional) Click Clear to delete all system logs.
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microSD only)

Playback mode allows you to playback video from the camera’s SD / microSD card.

@ NOTE

Playback is only available if your camera supports on-board recording using an SD / microSD card.

To playback video from the microSD card:

1. Use the calendar to select a day to search for video. The bar on the bottom populates
with video recorded on that day.
2. Click in the time bar to start playback.

OR

1. Click in the calendar to select a day to search for video.

2. Click . A list appears with video files from the selected day.

3. Click a time to select it.

00 - 00 : 00 - 23 : 59 : 53 [Ke¥

Download Format © mp4

Start Time  File Type

0
0
0
0
0
(1]
(1]
(1]
0
0
0
0
0

a1
Begin Time: 2015-01-29 09:08:44
EndTime: 2015-01-29 09:15:43
File Size 109224(KB)

4. Click then to start playback.
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7.1 Playback Controls

bobdb b b e

1. Play

2. Stop

3. Next frame

4. Slow

5. Fast

6. Mute

7. Volume

8. Show / hide recording type in time bar
9. Select playback time

10. Zoom into time bar

7.2 Backing up Video Files

You can download video files to your computer hard drive. Video files are saved in (.dav)
format. You can use the video player available from www.flirsecurity.com/pro to play
backup video files.

To backup video files:

1. Click in the calendar to select a day to search for video.

2. Click . A list appears with video files from the selected day.
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3. Click D next to the video file you would like to download to your computer’s hard

drive.
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Connecting a Camera in MPX
Mode

When your TCX Series thermal camera is in MPX mode, you can connect it to a FLIR
MPX DVR. To set your camera to MPX mode, insert the MPX terminator before powering
on the camera. See the diagram below for details.

ol
@ =
® o=

1. Connect the BNC video connector to a Video IN port on the DVR using a coaxial ca-
ble (not included),

2. Connect the MPX terminator to the Ethernet port.

3. Connect the camera to the appropriate power source (not included).

After powering on your DVR, you will have to set communication parameters for your
camera.

To set communication parameters for a camera in MPX mode:

1. Double-click on the channel of the MPX camera.
2. Right-click and click Main Menu.

3. Click and select Setting. Click Pan/Tilt/Zoom.
4. Configure the following settings:

¢ Under Channel, select the channel your MPX camera is connected to.
¢ Under Control Mode, select HDCVI.
¢ Under Protocol, select DH-SD1.

5. Click OK to save changes.

8.1 MPXOn-Screen Display (OSD)

TCX Series thermal cameras feature an on-screen display (OSD) menu that allows you
to configure thermal image settings and set the video standard to NTSC or PAL.

8.1.1 Accessing the OSD Menu

You can use your a FLIR MPX DVR’s PTZ controls to access the OSD menu.

To access the OSD menu:

1. In Live View, double-click the channel that has the MPX camera connected to open
in full-screen.
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2. Right-click and click Pan/Tilt/Zoom. Enter the system user name and password if
prompted. The PTZ menu opens.

@ NOTE

The following message will appear when attempting to access the PTZ menu if the communication
parameters have not been correctly set for your camera. See above for details.

3. Click the arrow in the PTZ control window to show advanced controls.

Speed 5

@ Zoom

Q Focus 0

4. Click @ The OSD menu appears over the camera image.

5. Use the on-screen controls to configure menu items:

¢ Up/down arrows: Select menu items.

o Left/right arrows: Change value for menu items.
e Cancel: Exit the OSD menu.

e Enter: Enter the menu item.
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8.1.2 OSD Menu Tree

The following table shows settings available in the OSD menu. For more information on
these setting, see 6.1.1 Settings, page 13.

8.1.2.1 TCXPTZ Camera MPX OSD
OSD Top Menu
Menu ltem Default Values
SYSTEM SETTINGS
SYSTEM INFORMATION DEVICE INFORMATION SERIAL NUMBER
SOFTWARE
FIRMWARE
VERSION
LIBRARY VERSION
BACK
FACTORY DEFAULT (Enter) Note: function is executed
immediately.
RESTART (Enter)
BACK (Enter) Return to previous OSD Menu.
CAMERA SETTINGS
BRIGHTNESS 50 0-100
SHARPNESS 0 -20 - 100 (increments of 5)
GAMMA 3 -8-8
ROI Full Screen « Full Screen
¢ Ground
¢ Horizon
e Sky
¢ Center 25%
¢ Center 50%
¢ Center 75%
¢ Custom
SMART SCENE (SSO) 15 0-100 (increments of 5)
COLORIZATION White Hot «  White Hot
¢ Black Hot
¢ Rainbow
Note: Additional options may be
available depending on camera
configuration or customization.
EZOOM (1.4 0X - 24X
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PRESET MODE

Default

¢ Default
¢ Low Contrast
¢ High Contrast
¢ Custom (1-5)
AGC MAX GAIN 8 0-255
AGC FILTER 1 0-255
AGC PLATEAU 15 0-255
RESTORE SETTINGS (Enter) Factory Defaults
BACK (Enter) Return to previous OSD Menu.
FUNCTION SETTINGS
PRESET PRESET NO 1-80
TITLE PRESET
SETTING
START
BACK
AUTO PAN PAN SPEED 1-8
START
STOP
BACK
AUTO SCAN AUTO SCAN NO 1-56
SET LEFT LIMIT SET LEFT LIMIT also sets the
SET RIGHT LIMIT tilt
SCAN SPEED
START
STOP
RETURN
TOUR TOUR NO 1-8
SETTING
DELETE
START
STOP
RETURN
PATTERN PATTERN NO 1-5
PROGRAM START
PROGRAM STOP
START
STOP
RETURN
PTZ SPEED 1-3
MENU IDLE 1-5, OFF
MENU PASSWORD PASSWORD ON/OFF
SETTING Enter a numeric password and
BACK confirm.
EXIT
PTZ AUTOSTOP 5-30, OFF
SET ZERO
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POWER UP POWER UP NONE, AUTO, SCAN, PRESET,
NO PATTERN, TOUR
BACK
EXIT
IDLE MOTION IDLE FUNCTION ON/OFF
IDLE TIME 1-255 MIN
IDLE ACTION NONE, PRESET, PATTERN,
PARAMETER (NO) TOUR, SCAN
BACK
EXIT
RETURN (ENTER) Return to the OSD Top Menu.
PRESET PROPERTIES
PRESET SWITCH 50 1-80
BRIGHTNESS 50 0-100
SHARPNESS 0 20-100, by 5s
GAMMA 3 8-8
ROI FULL SCREEN -8-8
Ground
Horizon
Sky
Center 25%
Center 50%
Center 75%
Custom
SMART SCENE (SSO) 15 0-100, by 5s
COLORIZATION White Hot White Hot
Black Hot
Rainbow
Note: Additional options may be
available depending on camera
configuration or customization.
EZOOM 0X 0X-24X
PRESET MODE Default Default
Low Contrast
High Contrast
Custom (1-5)
AGC MAX GAIN 8 0-255
AGC FILTER 1 0-255
AGC PLATEAU 15 0-255
BACK (Enter) Return to previous OSD Menu.

8.1.2.2 TCX Bullet Camera MPX OSD

Menu Item Default Option

BRIGHTNESS 50 0-100

SHARPNESS 0 -20 - 100 (increments of 5)
GAMMA 3 -8-8
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ROI

Full Screen
Full Screen

Ground
Horizon
Sky

Center 25%
Center 50%
Center 75%
Custom

SMART SCENE (SSO)

15 0 - 100 (increments of 5)

COLORIZATION

White Hot ¢ White Hot

* Black Hot
¢ Rainbow

Note: Additional options may be
available depending on camera
configuration or customization.

EZOOM

0X 0X-16X

STANDARD

NTSC NTSC/PAL

PRESET MODE

Default « Default

¢ Low Contrast
* High Contrast

RESTORE SETTINGS

Restore camera to factory defaults.

DEVICE INFORMATION

View information about the camera:

SERIAL NUMBER
SOFTWARE
FIRMWARE
LIBRARY VERSION
VERSION

EXIT

Exit the OSD menu.

8.1.2.3 TCX Mini Bullet Camera MPX OSD

Menu Iltem

Default Option

ROI

Full Screen
Full Screen

Ground
Horizon
Sky

Center 25%
Center 50%
Center 75%
Custom

STANDARD

NTSC NTSC/PAL

DEVICE INFORMATION

View information about the camera:

SERIAL NUMBER
SOFTWARE
FIRMWARE
LIBRARY VERSION
VERSION

EXIT

Exit the OSD menu.
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Connecting to Cameras with
FLIR Cloud™ CMS

FLIR Cloud™ Client is a central management software that allows you to view and man-
age multiple FLIR security systems on a PC or Mac. It includes support for FLIR Cloud™

Services, allowing a simple, secure connection to compatible systems over the Internet
with no network configuration required.

9.1 System Requirements

Your system must meet the system requirements below:

Description

Requirement

CPU

Core 2 Duo 3.0GHz

Operating System

Windows™ 8/7/Vista
Mac OSX 10.7 and above

Memory 2GB

Video 512 MB of video memory and above
Network (LAN) 10/100 BaseT Network

Network (WAN) 1 Mbps upstream

High-speed Internet service is required to re-
motely connect to your system.

9.2 Installing FLIR Cloud™ Client

1. Download and install the client software.

¢ PC Users: Download and install FLIR Cloud™ Client for PC from

www.flirsecurity.com/pro.

¢ Mac Users: Download and install FLIR Cloud™ Client for Mac from
www.flirsecurity.com/pro. Double click to extract the software. Then, drag

the software to Applications.

2. Once installation is finished, double-click the FLIR Cloud™ Client icon (
desktop or Applications list.

) from the
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3. Log into the Client Software using the Client Software user name (default: admin)
and password (default: admin) and then click Login.

9.3 Adding a Camera over the Local Network (LAN)

You can add cameras over a local network (LAN). The software will automatically scan
the network for compatible cameras.

Prerequisites:

¢ Connect the network camera to a router or switch on the network.
¢ |Install FLIR Cloud™ Client on a computer in the same network as the network camera.

To add a camera over the LAN:

1. Click and then click H

2. The client scans your LAN for connected cameras. Check your camera (a) and click
Add (b).

®@

3. Enter the password for your system (default: admin) and click OK.

4. Click then .
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5. Click-and-drag Default Group to the display window to open your camera in live
view.

<

Result

9.4 Adding a Camera over the Internet using a DDNS Address

It is recommended to sign up for a free FLIR DDNS address to connect to compatible
cameras over the Internet.

Prerequisites:

¢ Create a DDNS account at http://ddns.myddns-flir.com.

* Input the DDNS address into the network camera locally.

¢ Port forward the required ports on the router to the camera’s local IP address.
¢ |Install FLIR Cloud™ Client on a remote computer.

To add a camera using a DDNS address:

1. Click and then click H
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2. Click Add Device.

3. Enter the following:

O—
@_

0

o

3.1. Check By IP/Domain to add a camera using the DDNS address.

3.2. Device Name: Choose a name for your camera of your choice.

3.3. IP/DDNS Address: Enter the Domain Name/URL Request you received in

the email when you registered for DDNS followed by .myddns-flir.com.

E ot
For example, if your Domain Name/URL Request is tomsmith, enter tomsmith.myddns-flir.
com

3.4. Client Port: Enter the camera’s Client Port.

3.5. User Name: Enter the camera’s User Name (default: admin).

3.6. Password: Enter the system’s Password (default: admin).

4. Click Add.

5. Click then .
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6. Click-and-drag Default Group to the display window to open your camera in live
view.

<

Congratulations! You can now connect over the Internet to view and playback video on
your computer.

Result
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FLIR Cloud™ Client allows you to connect to multiple systems from a PC or Mac.

10.1 Home Page

The Home Page allows you to access all the tabs within the software. Each tab allows
you to access different features.

To open tabs:

Click a tab from the Home Page to open it or click the button at the top of the
screen from within any tab to open a new tab.

10.2 Live View
The Live View tab is where you can view live video from connected systems.

To view live video from a system:

-
1. Click and then click to create a Live View tab.

2. Click and drag a DVR, NVR, group, or individual camera to open live video. To ac-
cess individual cameras, you can click + to expand groups or systems.

e
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10.2.1 Live View Controls

1.

Log

® b b 60

Live display: Double-click to expand the area. Right-click to access additional op-
tions. Hold the mouse over the display area to access the camera toolbar.

bbbl

1.1.  Streaming quality: Shows the bitrate and resolution for the stream, and

shows if display is showing the Sub Stream or Main Stream.

Manual recording: Click to start/stop manual recording.

Snapshot: Click to save a snapshot.

Mute/unmute: Click to mute/unmute audio (audio camera required).

Not supported.

Instant playback: Plays back the most recently recorded video from the

camera. By default, it will play back the last 5 minutes of recorded video from

the camera.

1.7.  Digital zoom: Click to enable digital zoom mode. Click and drag over the dis-
play area to zoom on the camera. Then click and drag to pan. Click the icon
again to zoom out.

1.8. Disconnect.

Camera toolbar:

Sub Stream|205kbps, 352*240)

_L_k_k_l_.
oo

Split-screen mode: Click to select split-screen layout.

Aspect ratio: Use the drop down menu to select the aspect ratio for the selected
camera. Original uses the actual aspect ratio of the image. Full-win stretches the
image to fill up the entire display area.

EE Full-screen: Click to open full-screen mode. Press ESC to exit full-screen mode.

1
| Save view: Click to save the current display layout and open cameras as a view.
Then enter a name for the view.
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5. () Start/stop tour: Click to start the tour. During the tour the client will cycle
through all saved views every few seconds. Click again to stop the tour.

6. PTZ Controls: Controls for PTZ cameras (not included). See 10.3 Controlling PTZ
Cameras, page 75 for details.

7. View: Click View to access view menu. Then double-click on a view to open it in the
display area.

8. Devices: Shows a list of groups, cameras, and systems connected to the client. Drag
items to the display area to open live video. Right-click to view additional options.

10.2.2 Opening Live View in Multiple Monitors

If your computer has multiple monitors, you can open more than one Live View tab and
move them to secondary monitors. This allows you to monitor cameras on multiple moni-
tors at the same time.

@ NOTE

Using multiple monitors significantly increases the amount of computing resources necessary to run the
application and may affect performance.

To open Live View in multiple monitors:

-
1. Click and then click to create a Live View tab.
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2. Click and drag the tab outside of the client window to create a new window. You can

drag the window to one of the secondary monitors.

>

Result

10.3 Controlling PTZ Cameras

If you have PTZ cameras (not included), you can control them using the client.

@ NOTE

You must ensure the PTZ camera is properly connected to your system and your system is configured

to detect it before you can control them using the client.

To control PTZ cameras:

¢ Click the display area with the PTZ cameras and use the on-screen PTZ controls.

PTZ controls:

O—
@7

b4
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1. Open menu: Click to open camera OSD menu controls. This feature may not be sup-
ported for all camera models.

2. Move camera: Click the arrows to move the camera.

Click to open dynamic zoom mode. Then click and drag in the video area to
zoom in the camera on an area.

Zoom +/-: Click to zoom the camera in and out.
Focus +/-: Click to increase/decrease the focus.
Iris +/-: Click to increase/decrease the iris.
Advanced: Click to access advanced PTZ controls.

ook w

10.3.1 PTZ Presets
Presets will save a camera position for quick retrieval.

To add presets:

1. Click - to open the Advanced controls. Select Preset.

2. Click .

3. Select the number of the preset you would like to add.

4. Move the camera to the desired position.

5. Click - to save the current position as a preset.

To go to a saved preset:

1. Select the preset number from the list or click . to go to the currently selected
preset.

10.3.2 PTZ Tours
Tours will cycle through a set of presets.

To configure a PTZ tour:

1. Click - to open the Advanced controls. Select Tour.
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2. Click .

w

Under Cruise ID, select the number of the tour you would like to configure.
4. (Optional) Under Cruise Name, enter a name for the tour.

5. Use the chart to select which presets you would like to include in the tour and the or-
der of presets.

¢ Preset: Select the preset number.
* Time(s): Enter the time in seconds the camera will remain on the selected preset.

e Operation: Click . to add a preset to the tour. Click . to delete a preset from
the tour.

6. Click OK to save changes.
To run a PTZ tour:

1. Select the tour number and click .

10.3.3 PTZ Pattern
Patterns automatically cycle the camera between two positions.

To create a pattern:

1. Click - to open the Advanced controls. Select Pattern.

2. Select the number of the pattern you would like to set up.

3. Move the camera into the desired start position.
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4. Click - to start recording the pattern.

5. Move the camera to the desired end position. Then, click - to stop recording the

pattern.

To run a pattern:

1. Select the pattern number and click .

10.3.4 PTZ Scan
Scan automatically cycles between a left and right point.

To set up scan mode:

1. Click - to open the Advanced controls. Select Scan.

2. Move the camera to the desired left position and click .

3. Move the camera to the desired right position and click -

To run scan mode:

1. Click .

10.3.5 PTZPan
Pan makes the camera continuously pan 360°.

To run Pan mode:
1. Click - to open the Advanced controls. Select Pan.

2. Click .

10.4 Playback

You can use Playback mode to playback video saved on systems connected to the client.

To access Playback mode:

e Click and then click E to create a Playback tab.
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}

bbb

To playback video:

—_

Check the channels you would like to play back from in the Device List.
2. Under Type, check the file types you would like to search for.

e All: All recordings.

¢ General: Continuous recordings.

e MD: Motion recordings.

e Alarm: Alarm recordings. Your system must support alarm devices (not included)
to use this feature.

3. Under Stream, select Main Stream to search for Main Stream recordings (high qual-
ity) or Sub Stream to search for Sub Stream recordings (smaller file size).

4. Select the start time and end time for your search under From and To. You may not
search more than 24 hours of video.

5. Click Search. Wait for the client to find video saved to the system.

6. Click inside the play back bar to start playback.
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10.5 Playback Controls

o IR TP P

®_

8 @ b &

1. Display area: Double-click to expand/return to split-screen mode. Hold the mouse
over the display area to open the camera toolbar.

Main S5tream(1730.74 kb/s, 1280%720)

J E Snapshot: Click to save a snapshot.

. Digital zoom: Click to enable digital zoom mode. Then, click and drag to
zoom in. Click and drag to pan the camera. Click again to zoom out.

2. Event: Click to view recordings based on a list of events and files.

3. Record: Click to view recordings on a timeline.

4. Sync: Click to sync playback between channels. This forces all channels to playback
from the same time.

5. Pause/play.

6. Stop.

7. Frame-by-frame: Click to advance the video by a single frame.
8. Playback speed: Use the slider to adjust the playback speed.
9. Mute.

10. Volume.

11. Split-screen: Select split screen configuration.

12. Full-screen: Click to open playback in full-screen. Press ESC to exit full-screen.

13. Timeline zoom: Use the slider to zoom in/out on the timeline.

14. Playback timeline: Shows recordings from the selected channels on a timeline.
Click inside the timeline to start playback or select a playback time. Each type of re-
cordings is shown in a different color. Continuous recordings are green, motion re-
cordings are yellow, and alarm recordings are red.

15. Video clip: Click to start a video clip. You can download video clips to your hard
drive.

16. Download list: Click to see a list of files you have downloaded and the progress of
files that are currently downloading.

17. Search: Search for video on the selected channels based on the search parameters
you set.
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18. Device list: Select the channels you would like to search or playback video from.

10.6 Downloading Video to your Computer Hard Drive

You can download video to your computer hard drive to save important events or share
them. It is recommended to download video of important events as soon as possible to
ensure they are not overwritten by new recordings.

@ NOTE

PC Users: You may need to run FLIR Cloud™ Client as an administrator to download files to your hard
drive.

To download video files:

1. Start playing back video using the steps in 10.4 Playback, page 78.

2. Click . to start a video clip at the current playback time. Click . to stop the video
clip.

3. Configure the following save options:

* Path: Use the default save folder or click Browse to select a different folder.
* File Format: Select Original Format to save to .dav format (requires the video
player). Select AVI to save files to .avi format (can be played in VLC Media Player).

@ NOTE

The Mac version only supports downloading video to .dav format.

* Download Video Player: Check to save a copy of the video player with the down-
loaded file.

4. Click OK to start the download. A status screen will pop up to show progress on
downloaded files.

@ NOTE

To retrieve downloaded video files:

e PC Users: Browse to the folders listed in General>File.

* Mac Users: Browse to the folders listed in General>File. To get to the default location, open Appli-
cations in Finder, right click on FLIR Cloud Client and select Show Package Contents. Then, nav-
igate to the desired folder.

10.7 Alarm

The Alarm menu allows you to view a list of alarms received by the client software.

@ NOTE

You must set up alarms in the Alarm CFG menu before they will appear in this list. See 10.12 Alarm
CFG, page 86 for more details.
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To access Alarms:

e Click and then click H

Alarm menu overview:

O— —®
@_

®_

Number of alarms: Shows the number of open alarms.

2. Alarm list: Shows the list of alarms and information on when they occurred and
which systems and channels triggered them.

3. Alarm Process: You can close alarms by selecting one of the options and clicking
OK.

4. Options: Check to enable the following:

—_

¢ Display Link Video: Open live video to monitor alarms on a continuous basis.
* Display Overlay Window: Show the overlay controls. They allow you to enable/
disable sound alerts and quickly jump back to the Alarm menu from another tab.

* Pause Refresh: Stop refreshing the live video in the video popup.

10.8 Log

The Log menu allows you to view logs for the client software or to view logs for con-
nected systems.

To access logs:

E)
e Click and then click .

To view client logs:

1. Click Client Log to view logs for the client software.
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2. Configure the following:

» Start Time/End Time: Select the start and end times to search for logs.
* Log Type: Select the type of logs to search for.

3. Click Search.
To view logs from connected systems:

1. Click Device Log to view logs from connected systems.

2. Configure the following:

* Start Time/End Time: Select the start and end times to search for logs.
¢ Log Type: Select the type of logs to search for.
¢ Device Name: Select the system you would like to view logs from.

3. Click Search.

10.9 E-map

E-Map allows you to place cameras over a still image. For example, you can use the E-

Map to create a virtual map of your cameras over a floor plan of your home or business.

To create an E-map:

1. Click and then click ﬂ

2. Click Add Map.
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3. Configure the following:

e Name: Enter a name for your e-map of your choice.

¢ Picture: Click File and then select a .png, .bmp, or .jpg image on your computer
to use as the e-map.

¢ Describe (optional): Enter a text description of the e-map.

4. Click Save.
5. Click Edit to edit the e-map.

6. Click and drag cameras from the device list to place them on the map.

.

To open cameras from the e-map:
1. Click View.
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2. Double-click cameras on the map to open live video.

10.10 Devices
The Devices menu is where you can manage systems connected to the client software.

To access the Devices menu:

¢ Click and then click H

Devices overview:

b

1. Devices Found: Shows systems that are connected to the same network as the
computer where the client is installed. Once you connect to the system, it moves to
the bottom of the screen.

Search: Refresh the list of systems connected to the network.

Add: Add checked systems to the client software.

Device list: Shows a list of systems connected to the client software, and shows
which systems are online.

Add Device: Add a remote system using a Device ID or IP/DDNS address.
Delete: Delete the selected system.

Import: Import a list of systems from a saved .xml file.

Export: Export a list of currently connected systems to an .xml file. This is useful if
you need to re-install the software or if you want to open the same list of systems on
a different computer.

9. Delete: Delete system.

10. Manual connect/disconnect: Manually connect/disconnect the system.

11. Edit: Edit the connection details for the system.

rpODN

© N o

10.11 Device Config

The Device Config menu allows you to remotely configure settings for connected
systems.
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To access the Device Config menu:

e Click and then click

¢ Click on a system in the device list to see the settings available for that system and
then configure settings as needed.

NOTE

The settings available depend on the model of system you have.

10.12 Alarm CFG

The Alarm CFG menu allows you to configure alarms for the client software. The client
software will alert you by popping up live video and playing sound alerts.

@ NOTE

Alarm upload must be enabled on the system in order for it to send the alarm to the client software.

To create alarms:

1. Click and then click

2. Click Add to create a new alarm.
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3. Inthe Alarm sources menu, you set up the parameters that trigger the alarm.

Under Alarm Type, select the alarm type that will trigger an alarm. For example,
you can select Motion Detect for the alarm to be triggered by motion.

Select the systems or channels you would like to trigger an alarm. Continuing the
example, if CAM 1 is selected, the alarm will be triggered if there is motion on
CAM 1.

Click Next.

4. Inthe Alarm link menu, you set up the responses to alarms. Select the channels that
will pop up or alarm out devices (not included; not all systems support alarm out devi-
ces) that will be triggered by an alarm.

For each channel selected, configure the following:

Video: Pop up a window with live video from the selected channel, like the one
below.

Record: Record video from the selected channel.

@ NOTE

PC Users: You may need to run the client software as admin to record.

Preset: If you select a PTZ camera, you can select the preset that will be activated
when an alarm occurs.

Stay Time: Enter how many seconds the video window will stay open or record
when an alarm occurs.
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5. Click Next.
6. In the Period window, configure times the alarm will be activated.

7. Click Confirm to save the alarm.

To manage alarms:

Export: Export current list of alarms as an xml file.
Import: Import list of alarms.

Delete: Delete selected alarm.

Add: Add new alarm.

Alarms.

On/off: Click to enable/disable alarm.

Delete: Click to delete alarm.

Edit: Click to edit alarm settings.

ONOO AN~

10.13 Tour & Task

The Tour & Task menu is where you can set up custom views for the system. You can al-
so set up tours, which sets the client to automatically cycle through views.

To start a tour:

e Click - in Live View to start a tour. The live view will automatically cycle through all
views you have set up in the Tour & Task menu. Click again to stop the tour.

To add views:

1. Click and then click
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2. Click + to create a new view.

3. Under Name, enter a name for your view.

4. Under Stay Time, enter the number of seconds the view will be shown before the cli-
ent switches to the next view.

5. Select the split-screen mode you would like to use for the view and then click and
drag channels to the empty grid areas to select channels to be shown in the view.

<

6. Click Save to save the view. Or click Add More to save the view and create another
view.
10.14 Account

The Account menu is where you can set up user accounts and passwords for the client
software. To simplify management, you can group user accounts according to role. A role
determines the permissions an individual user account can have.

To access the account menu:
¢ (Click and then click n

10.14.1 Managing User Accounts

By default, the client software includes an admin account that has full access to all fea-
tures of the software and all connected systems. You can add user accounts with cus-
tomized levels of access.

@ NOTE

The admin account cannot be deleted. The default user name for the admin account is admin and the
default password is admin.
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To create a user account:
1. Click Add.

2. Configure the following settings for the user account:

¢ User Name: Enter a user name for the account.

* Role: Select the role for the user account. By default, the user account gains all
the permissions of the role selected, but you can deactivate permissions as
needed.

¢ Password/Confirm Password: Enter the password for the user account.

* Remarks (Optional): Enter a text description of the user account.

¢ User Rights: Check the permissions that will apply to the user account. If you
click on LiveView, Playback, and PTZ, you can select which channels the user ac-
count can access in the Channel List section.

3. Click Save to create the account.

To switch between user accounts:

¢ Click u

To modify a user account:

@ NOTE

Admin accounts with Account Setup permissions can change account passwords. A user cannot
change his own password.

e Click . next to the user account you would like to modify. Edit the user account de-
tails and click Save.

To delete a user account:

1. Click - next to the user account you would like to delete. Click OK to confirm.
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10.14.2 Managing Roles

Roles make it easier to manage user accounts by determining the permissions an indi-
vidual user account can have. By default, a new user account is given all the permissions
of the role they are assigned to.

To create a role:

1. Click the Role tab.
2. Click Add.

3. Configure the following settings for the role:

* Role Name: Enter a name for the role.

¢ Remarks (Optional): Enter a text description of the role.

* Role Rights: Check the permissions that will apply to user accounts assigned this
role. If you click on LiveView, Playback, and PTZ, you can select which channels
may be accessed in the Channel List section.

4. Click Save.

To modify a role:

* Click . next to the role you would like to modify. Edit the role details and click Save.

To delete a user account:
1. Click - next to the role you would like to delete. Click OK to confirm.

10.15 General
The General menu is where you can configure application settings for the client software.

To access the General menu:

@
e (Click and then click .
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10.15.1 Basic

The Basic menu contains general settings for the client software.

The Basic menu contains the following settings:

Log Saved Time: Select the number of days you would like the client to save log
entries.

Instant Playback Time: Select the number of minutes the system will go back when
you start an instant playback.

Network Capability: Select the speed of your computer’'s network connection.
Resume Live View State: Check for the client to resume live view when it starts up.
The live view will open to the last view that you had open.

Auto login application: Check for the client to automatically login when it starts up
without entering a user name or password.

Auto Login Windows: Not supported.

Language: Select the language for the client software.

Sync Time: Check to have the client software sync time with your computer’s system
time. Select the time the software will sync the time. Click Synec Now to manually sync
the time.

Time Format: Select 12-Hour or 24-Hour time format. You must close the client and
restart it to apply this setting.

@ NOTE

Click Save to save setting changes.

10.15.2 File

The File menu allows you to select the folders where the client software will save down-
loaded video files and snapshots.
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The File menu contains the following options:

* Snapshot Path: Click Browse to select the default folder to save snapshots.

* Record Path: Click Browse to select the default folder to save video recordings.

¢ Config Path: Click Browse to select the folder where the client will save software
config files.

@ NOTE

Click Save to save setting changes.

PC Users: You may need to run the client software as admin to save files to enable snapshot or video
recording.

10.15.3 Alarm Prompt

The Alarm Prompt menu allows you to configure audio alerts. The client will play audio
alerts when events occur. You can replace the default sounds with any .wav file.

@ NOTE

You must configure alarms in the Alarm CFG menu before the client will play alarm sounds.

The Alarm Prompt menu has the following options:

* Open Audio: Check to enable audio alerts.

* Loop: Check to repeat audio alerts until acknowledged.

* Camera Masking: Select or preview the sound that will play for camera masking
alarms.

¢ Motion Detect: Select or preview the sound that will play for motion detection.

¢ Video Loss: Select or preview the sound that will play for video loss alarms.

* Disk Full: Select or preview the sound that will play for disk full alarms.

¢ Disk Error: Select or preview the sound that will play for disk errors.

¢ External: Select or preview the sound that will play for external alarms (triggered by
sensor devices, which may not be supported on all systems).

* E-map flashes when alarm occurs: If the camera has alarms enabled and is added

to an e-map, a ™ appears on the e-map when an event occurs.

@ NOTE

Click Save to save changes.

10.15.4 Version

The Version menu shows you which version of the client software you are using. It is rec-
ommended to always run the latest version of the software. To find the latest version of
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the client software, visit www.flirsecurity.com/pro, search for the model number of your
product, click on your product in the search results, and click on the Downloads tab.
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Smartphone and Tablet Apps

FLIR Cloud™ is a free mobile app that is compatible with iPhone, iPad, and android

devices.
Platform Supported Versions App Name Get App From
and Devices
i0S iPhone/iPad FLIR Cloud™ Apple App Store
Android Android FLIR Cloud™ Google Play Store

See www.flirsecurity.com/pro for the latest list of supported apps and devices.

1

FLIR Cloud™ is an iPhone app that allows you to remotely view your network camera.

1.1 iPhone

11.1.1 Prerequisites

Port 80 and 35000 (or your HTTP and client ports, if you have changed them) must
be port forwarded on your router to your camera’s IP address.

You must create a DDNS account, and have the DDNS settings configured in your
network camera.

The network camera must have Internet access.

You must have a DDNS address to log in remotely.

An iTunes account.

@ NOTE

You will need to create an iTunes account before you can download the app. An iTunes store ac-
count requires a valid credit card number. The app is free of charge.
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11.1.2 Connecting to Your Network Camera on an iPhone
1. Download FLIR Cloud™ for free from the App Store.

2. Tap onthe FLIR Cloud™ icon (ch) to start the app.

@ NOTE

The first time it opens, the app will ask for permission to send push notifications and to access Pho-
tos. It will only send notifications if you enable motion-activated push notifications in the Push Con-
fig menu. It needs access to Photos to save snapshots and video clips to the local storage on your
mobile device.

3. InLive View, tap then .

O >0

4. Configure the following:

4.1. Register Mode: Select IP/Domain.

4.2. Name: Choose a name for your network camera of your choice.

4.3. Address: Enter the IP address or DDNS address of your network camera. (e.
g. tomsmith.myddns-flir.com).

4.4. Client Port: Enter the Client Port (default: 35000).

4.5. User Name: Enter the network camera’s User Name (default: admin).

4.6. Password: Enter the network camera’s password (default: admin).

5. Tap Connect.
6. The app opens in Live View and streams video from your camera.
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11.1.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.

Live View Overview

© ¢

—_

Menu: Tap to bring up the menu.

Display Area: Double-tap to open a channel in full screen. Swipe left or right to se-
lect a different page of channels.

3. Pages: Shows the number of pages available and highlights the currently selected
page.

Split: Select the split-screen layout.

Snapshot: Tap to take a snapshot from the currently selected channel.

Control Bar: Contains the following options. Swipe left or right to access more
options.

n

ook
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6.1.
6.2.
6.3.
6.4.
6.5.
6.6.
6.7.

6.8.

bo0d b0 de

Quick Playback: Tap to start/stop quick playback.

PTZ Controls: Open/close PTZ controls. PTZ camera required.

Video Quality: Open/close streaming quality panel.

Alarms: Tap to activate an alarm output device connected to the camera
(cameras with alarm 1/O only).

Audio: Tap to mute / un-mute audio coming from the camera (audio-enabled

cameras only; must have self-powered microphone connected to the camera).

eras only; must have amplifier or speakers connected to the camera.)
Digital Zoom: Tap to activate digital zoom mode for the currently selected
camera. Pinch the screen inward to zoom out and outward to zoom in.
Color Settings: Tap to access color controls for the currently selected
camera.

7. Manual Record: Tap to start/stop manual recording.
8. Access Favorites.

9. Connect/disconnect all: Connect to/disconnect from all previously added cameras.
10. Device List: Tap to open a list of devices. You can use the Device List to open multi-

ple

11.1.4

systems or cameras at once.

Controlling PTZ Cameras

If you have PTZ cameras, you can control them from the app.

To control PTZ cameras:

1. Tap the display area the PTZ camera is connected to.

2. Tap

to open PTZ controls.

Microphone: Tap to activate the intercom to the camera (audio-enabled cam-
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PTZ Controls

A—

@— —®

Live Display: Swipe to move the camera. Pinch to zoom in/out.

Iris: Tap to show iris controls.

Focus: Tap to show focus controls.

Zoom: Tap to show zoom controls.

Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the check mark to go to the preset.

@ NOTE

You must set presets for the camera using the system’s local menus before you can use this
feature.

AN

11.1.5 Viewing Snapshots and Videos with Local Files

If you have saved snapshots or videos using the app, you may open them with Local
Files.
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To access Local Files:

e Tap E to access the menu, and then tap Local Files.
Local Files Overview

Menu: Return to menu.

Files: Tap to open files.

File Type: Tap the options to select video files or snapshots.
Options: Tap to delete or export files to your device’s local storage.

@ NOTE

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4
format.

rPodO=

11.1.6 Using Playback Mode on iPhone

You can access recorded video on your system using your iPhone.

@ NOTE

You must enable Sub Stream recording to use playback mode on mobile devices.
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To use Playback Mode:

1. Tap E to access the menu, and then tap Playback.

2. Tap + and select a channel to playback.

—>

3. Select the date, then the start and end times to playback.
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4. Use the on-screen controls to control playback.

Playback Controls

T

@

3

O —®

%__| —
6 0 ¢

4.1. Display Area: Double-tap to open in full-screen.

4.2. Play/pause.

4.3. Time Bar: Tap inside the bar to fast forward or rewind.

4.4. Previous: Select previous video file.

4.5. Next: Select next video file.

4.6. Snapshot: Tap to take a snapshot from the selected camera.
4.7. Stop All: Stop playback on all channels.

4.8. Audio: Tap to mute / un-mute audio coming from the camera (audio-enabled
cameras only; must have self-powered microphone connected to the camera).

4.9. Manual Record: Tap to start/stop recording to your mobile device’s local

storage.
4.10. Fast.
4.11. Slow.

4.12. Time Range: Tap to change the range of time shown in the time bar.
4.13. Next frame.
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11.1.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device
when one of your cameras detects motion. Once you have received a push notification,
you can select it to open live video or a snapshot attachment from the camera that de-

tected motion.

@ NOTE

Your cameras must have motion detection activated to receive push notifications.

To Enable Push Notifications:

1. Tap E to access the menu, and then tap Push Config.

2. Tap the system you would like to configure.
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3. Tap Motion Detect and then check each channel you would like to receive push noti-
fications from.

4. Tap to save changes. You will now receive a notification when one of the se-
lected cameras detect motion.

11.1.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

@ NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

e Tap E to access the menu, and then tap Event List.

Event List Overview

—®
®7

1. Events: Shows the details of each motion detection event. Tap the event to view the
video or snapshot.
2. Delete All: Tap to delete all events in the Event List.

@ NOTE

To delete a single event, swipe it to the left and then tap Delete.

«—

11.1.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly
bring up the group of cameras in Live View without having to individually select each
camera.
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To use Favorites:

1. Tap E to access the menu, and then tap Favorites.

2. Tap a group to configure an existing group.

@ NOTE

Tap to create a new group and then enter a name for the new group.

@ NOTE

To rename an existing group, press and hold the group. Enter the name in the pop-up that appears
and tap OK.

3. To add cameras to the group, tap .

4. Select the cameras you would like to add to the group. Tap to save changes.

@ NOTE

To delete cameras added to the group, select the group in the group list. To delete a camera from
the group, swipe the camera to the left and then tap Delete.

To Open Favorites in Live View:

1. Tap E to access the menu, and then tap Live View.
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2. Tap - and then tap to open the group.

O

11.1.10 Using the E-Map
E-Map allows you to place cameras over a still image. For example, you can use the E-

Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap E to access the menu, and then tap E-Map.

2. Tap .

3. Select a .jpg image on your mobile device.
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4. Tap
Repeat to add additional cameras.

5. Tap . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

@=

1. Tap in Live View.

2. Select the E-Map in the Device List.

3. Tap the camera or cameras to select and then tap Connect to open the cameras.

f%ll and select a camera. Drag the camera on the screen to place it on the map.
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11.1.11 Device Manager
You can use Device Manager to add, delete, or edit your systems.

To Access Device Manager:

e Tap E to access the menu, and then tap Device Manager.

To edit a system:

%
1. Tap the system in Device Manager. Tap .

2. Edit the connection details as needed.
3. Tap Connect to save changes and connect to the system.

To delete a system:

1. Tap the system you would like to delete.

2. Tap n Tap OK to confirm.

11.2 iPad

FLIR Cloud™ is an iPad app that allows you to remotely view your system.

11.2.1 Prerequisites

¢ Port 80 and 35000 (or your HTTP and Client Ports, if you have changed them) must
be port forwarded on your router to your camera’s IP address.

* You must create a DDNS account, and have the DDNS settings configured in your
network camera.

* The network camera must have Internet access.

¢ You must have a DDNS address to log in remotely.

¢ AniTunes account.

@ NOTE

You will need to create an iTunes account before you can download the app. An iTunes store ac-
count requires a valid credit card number. The app is free of charge.

11.2.2 Connecting to your network Camera on an iPad

1. Install FLIR Cloud™ for free from the App Store.

N
2. Tap onthe FLIR Cloud™ icon (va) to start the app.

@ NOTE

The first time it opens, the app will ask for permission to send push notifications and to access Pho-
tos. It will only send notifications if you enable motion-activated push notifications in the Push Con-
fig menu. It needs access to Photos to save snapshots and video clips to the local storage on your
mobile device.

3. InLive View, tap then

4. Tap Device Manager.
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5. Tap Add.

6. Configure the following:

6.1. Register Mode: Select IP/Domain.
6.2. Name: Choose a name for your network camera of your choice.

6.3. Address: Enter the IP address or DDNS address of your network camera. (e.

g. tomsmith.myddns-flir.com).
6.4. Client Port: Enter the Client Port (default: 35000).
6.5. User Name: Enter the network camera’s User Name (default: admin).
6.6. Password: Enter the network camera’s password (default: admin)
6.7. Channels: Enter 1.

7. Tap Start Live View.
8. The app opens in Live View and streams video from all connected cameras.

11.2.3 Live View Interface

You can use FLIR Cloud™ in landscape or portrait mode.
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Live View Overview

®7

—_

7.
8.

9.

bbboodbd

Display area: Double-tap to open camera in full screen.

Favorites: Slide to select favorites.

Audio: Tap to mute / un-mute audio coming from the camera (audio-enabled cam-
eras only; must have self-powered microphone connected to the camera).
Disconnect all: Disconnect all cameras.

Add to favorites: Add the current view to favorites.

Snapshot: Tap to take a snapshot from the currently selected channel.

@ NOTE

You can view or share snapshots using the Photos app.

Change display view.

Microphone: Tap to activate the intercom to the camera (audio-enabled cameras on-
ly; must have amplifier or speakers connected to the camera.)

Manual record: Tap to start/stop manual recording from this channel.

10. Alarm Output: Click to activate an alarm output device connected to the camera

(cameras with alarm 1/0 only).

11. Open menus.
12. Select different camera.
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11.2.4 Controlling PTZ Cameras
If you have PTZ cameras, you can control them using the app.
To control PTZ cameras:

1. In Live View, double-tap the window the PTZ camera is connected to.
2. Slide the middle controls to the right to access PTZ controls.

—

PTZ Controls

® @® 6
®
@ @

Live display: Swipe to move the camera. Pinch to zoom in/out.

Direction buttons: Tap to move the camera.

Zoom: Tap to zoom the camera in/out.

Focus: Tap +/- to adjust the focus.

Iris: Tap to adjust the iris.

PTZ/EPTZ: Tap to switch between PTZ and EPTZ mode. Use PTZ mode to control
PTZ cameras. Use EPTZ mode to activate digital zoom mode on non-PTZ cameras.
Goto preset: Tap to go to a camera preset.

ok wh~

N

@ NOTE

You must set presets for the camera using the system’s local menus before you can use this
feature.
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11.2.5 Using Playback Mode on iPad

You can access recorded video on your system using your iPad.

@ NOTE

You must enable Substream recording to use playback mode on mobile devices.

To use Playback Mode:

1. From Live View, tap then

2. In Portrait Mode: Tap +, select the start time and end time for your search, and select
the camera you would like to playback.
OR

In Landscape Mode: Select the start time and end time for your search, and drag the
camera you would like to playback to the display area.

=

3. Use the playback controls.
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Playback Controls

L4

Display area: Double-tap to open camera in full screen.
Play/pause.

Previous file.

Next file.

Time range: Tap to change the range of time shown in the time bar.
Time Bar: Tap inside the bar to fast forward or rewind.

ok wN =

@ NOTE

Playback controls are only shown in portrait mode.

11.2.6 Using Local Files to View Manual Recordings
You can view manual recordings saved to your mobile device using the Local Files menu.

To view manual recordings:

1. From live view, tap then

2. Tap Local Files.
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3. Tap avideo file to openiit.

To delete videos:
1. Tap Edit.

2. Select the videos you would like to delete and tap .

11.2.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device
when one of your cameras detects motion. Once you have received a push notification,
you can select it to open video or an image from the camera that detected motion.
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@ NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. From live view, tap then

2. Tap Push Config.
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3. Tap the slider for the system you would like to configure.
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4. Tap Motion Detect then check each channel you would like to receive push notifica-
tions from.

5. Under Type, select Playback to attach a video file with each push natification. Or, se-
lect Picture to attach a stillimage of the camera that detected motion.

6. Tap OK to save change. Whenever the selected cameras detect motion, you will re-
ceive a notification.

11.2.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

E nore

You must configure push notifications before you can use the Event List.

To access the Event List:

1. From live view, tap then
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11.2.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly
bring up the group of cameras in Live View without having to individually select each
camera.

To create favorites:

1. InLive View, tap to save the cameras that are currently open as a favorite.
2. Enter a name for the favorite and tap OK.
To open favorites in Live View:

¢ In Live View, slide the dial to cycle through favorites.

To edit favorites:

1. From live view, tap then

2. Tap Favorites.
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3. Tap the favorite you would like to edit.

4. Tap Edit.
5. Select the cameras you would like to include in the favorite and then tap Save.
11.2.10 Using the E-Map

E-Map allows you to place cameras over a still image. For example, you can use the E-
Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. From live view, tap then
2. Tap Add.
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3. Select a.jpg image file on your mobile device.

4. To edit the E-map:

b o 6

4.1. Select Image: Select different image file to use for your E-Map.

4.2. Add Camera: Tap + to select cameras to add to your E-Map. Then drag the
camera to place it on the E-Map.

4.3. Delete E-Map.

5. When you complete editing the E-Map, tap Save and enter a name for the E-Map to
save changes.

To open cameras using the E-Map:
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1. Inlive view, tap + on an empty display window and select the E-Map.
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2. Tap a camera from the E-map to open.

11.2.11 Using the Device Manager
Device Manager allows you to manage your systems.

To access Device Manager:

1. From live view, tap then
2. Tap Device Manager.
To delete a system:

1. Tap the system to select it.

2. Tap . Tap Yes to confirm.

To modify a system:

1. Tap a system to select.
2. Tap the system again to open the edit screen.
3. Update the connection details as needed and then tap Start Live View.
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11.3 Android

FLIR Cloud™ is an Android app that allows you to remotely view your network camera.

11.3.1 Prerequisites

Port 80 and 35000 (or your HTTP and client ports, if you have changed them) must
be port forwarded on your router to your camera’s IP address.

You must create a DDNS account, and have the DDNS settings configured in your
network camera.

The network camera must have Internet access.

You must have a DDNS address to log in remotely.

A Google Play account.

11.3.2 Connecting to Your Network Camera on Android

1.

Download FLIR Cloud™ for free from the Google Play Store.

2. Tap on the FLIR Cloud™ icon (CQB) to start the app.

3. InLive View, tap then .

O >0

4. Configure the following:

4.1. Register Mode: Select IP/Domain.

4.2. Name: Choose a name for your network camera of your choice.

4.3. Address: Enter the IP address or DDNS address of your network camera. (e.
g. tomsmith.myddns-flir.com).

4.4. Client Port: Enter the Client Port (default: 35000).

4.5. User Name: Enter the network camera’s User Name (default: admin).

4.6. Password: Enter the network camera’s password (default: admin).

5. Tap Connect.
6. The app opens in Live View and streams video from your cameras.

11.3.3 Live View Interface

You can use FLIR Cloud™ in portrait and landscape mode.
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Live View Overview
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Menu: Tap to bring up the menu.
Display Area: Double-tap to open a channel in full screen. Swipe left or right to se-
lect a different page of channels.
Pages: Shows the number of pages available and highlights the currently selected
page.
Split: Select the split-screen layout.
Snapshot: Tap to take a snapshot from the currently selected channel.

Control Bar: Contains the following options. Swipe left or right to access more
options.

$00d b0 do

6.1. Quick Playback: Tap to start/stop quick playback.

6.2. PTZ Control: Open/close PTZ controls. PTZ camera required.

6.3. Video Quality: Open/close streaming quality panel.

6.4. Alarms: Tap to activate an alarm output device connected to the camera
(cameras with alarm 1/O only).

6.5. Audio: Tap to mute / un-mute audio coming from the camera (audio-enabled
cameras only; must have self-powered microphone connected to the camera).

6.6. Microphone: Tap to activate the intercom to the camera (audio-enabled cam-
eras only; must have amplifier or speakers connected to the camera.

6.7. Digital Zoom: Tap to activate digital zoom mode for the currently selected
camera. Pinch the screen inward to zoom out and outward to zoom in.

6.8. Color Settings: Tap to access color controls for the currently selected
camera.

Manual Record: Tap to start/stop manual recording.
Access Favorites.
Connect/disconnect all: Connect to/disconnect from all previously added cameras.
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10. Device List: Tap to open a list of devices. You can use the Device List to open multi-
ple systems or cameras at once.

11.3.4 Controlling PTZ Cameras
If you have PTZ cameras, you can control them from the app.
To control PTZ cameras:

1. Tap the display area the PTZ camera is connected to.

2. Tap to open PTZ controls.
PTZ Controls

O—

@— —®

Live Display: Swipe to move the camera. Pinch to zoom in/out.

Iris: Tap to show iris controls.

Focus: Tap to show focus controls.

Zoom: Tap to show zoom controls.

Goto preset: Tap to access preset controls. Then use the sliders to select a preset
and then tap the check mark to got the preset.

@ NOTE

You must set presets for the camera using the system’s local menus before you can use this
feature.

S

11.3.5 Viewing Snapshots and Videos with Local Files

If you have saved snapshots or videos using the app, you can open them with Local Files.
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To access Local Files:

e Tap E to access the Menu, and then tap Local Files.
Local Files Overview

?

> —@
@O—

Menu: Return to Menu.

Files: Tap to open files.

File Type: Tap the options to select video files or snapshots.
Options: Tap to delete or export files to your device’s local storage.

E ot

Exported snapshots and video files are saved to the Photos app. Video files are saved to MP4
format.

rPOD

11.3.6 Using Playback Mode on Android

You can access recorded video on your system using your Android phone.

E norme

You must enable Sub Stream Recording to use playback mode on mobile devices.

To use Playback Mode:

1. Tap E to access the Menu, and then tap Playback.
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2. Tap + and select a channel to playback.

—>

3. Select the date then the start and end times to playback.
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4. Use the on-screen controls to control playback.

Playback Controls

T

o
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Display Area: Double-tap to open in full-screen.

Play/pause.

Time Bar: Tap inside the bar to fast forward or rewind.

Previous: Select previous video file.

Next: Select next video file.

Snapshot: Tap to take a snapshot from the selected camera.

Stop All: Stop playback on all channels.

Audio: Tap to mute / un-mute audio coming from the camera (audio-enabled
cameras only; must have self-powered microphone connected to the camera).
Manual Record: Tap to start/stop recording to your mobile device’s local
storage.

Fast.

Slow.

Time Range: Tap to change the range of time shown in the time bar.

Next frame.

11.3.7 Enabling Push Notifications

You can have the app send push notifications to the notifications area on your device
when one of your cameras detects motion. Once you have received a push notification,
you can select it to open live video or a snapshot attachment from the camera that de-
tected motion.
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@ NOTE

Your cameras must have motion detection activated to receive push notifications.

To enable Push Notifications:

1. Tap E to access the menu, and then tap Push Config.

2. Tap the system you would like to configure.

3. Tap Motion Detect and then check each channel you would like to receive push noti-

fications from.

4. Tap to save changes. You will now receive a notification when one of the se-
lected cameras detect motion.
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11.3.8 Using the Event List

The Event List menu shows a list of events that were sent to your device via push
notifications.

@ NOTE

You must configure push notifications before you can use the Event List.

To access the Event List:

e Tap E to access the menu, and then tap Event List.

Event List Overview

—®
®_

1. Events: Shows the details of each motion detection event. Tap the event to view the
video or snapshot.
2. Delete All: Tap to delete all events in the Event List.

@ NOTE

To delete a single event, press and hold the event in the event list and tap OK in the pop-up that
appears.

11.3.9 Using Favorites

Favorites allows you to select a group of cameras as a favorite. You can then quickly
bring up the group of cameras in Live View without having to individually select each
camera.

To use Favorites:

1. Tap E to access the menu, and then tap Favorites.

2. Tap a group to configure an existing group.

E nore

Tap to create a new group and then enter a name for the new group.

3. To add cameras to the group, tap .
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4. Select the cameras you would like to add to the group. Tap to save changes.

E norme

To delete cameras from a group, press and hold the camera and tap delete. Press and hold a group
to rename or delete it.

To open Favorites in Live View:

1. Tap E to access the menu, and then tap Live View.
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2. Tap - and then tap to open the group.

O

11.3.10 Using the E-Map
E-Map allows you to place cameras over a still image. For example, you can use the E-

Map to create a virtual map of your cameras over a floor plan of your home or business.

To add an E-Map:

1. Tap E to access the menu, and then tap E-Map.

2. Tap .

3. Select a .jpg image on your mobile device.
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4. Tap
Repeat to add additional cameras.

5. Tap . Choose a name for your E-Map and then tap OK.

To open cameras from an E-Map:

@=

1. Tap in Live View.

2. Select the E-Map in the Device List.

3. Tap the camera or cameras to select and then tap Connect to open the cameras.

f%ll and select a camera. Drag the camera on the screen to place it on the map.
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11.3.11 Device Manager

You can use Device Manager to add, delete, or edit your systems.

To access Device Manager:

e Tap E to access the menu, and then tap Device Manager.

To edit a system:

&
1. Tap the system in Device Manager. Tap .

2. Edit the connection details as needed.
3. Tap Connect to save changes and connect to the system.

To delete a system:

1. Tap the system you would like to delete.

2. Tap . Tap OK to confirm.
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RTSP streaming allows you to stream video from the camera using a web address. It is
an optional connectivity method used by 3rd party software applications.

B nore

The instructions in this section are using VLC Media Player. VLC Media Player is a free software pro-
vided at www.videolan.org. FLIR cannot provide support for VLC Media Player or any other 3rd party
software. Please contact the software vendor for technical support related to 3rd party software

applications.

To connect to the video stream using VLC Media Player:

1. Open VLC Media Player.
2. Click Media>Open Network Stream.

3. Enter the RTSP address in the following format:

¢ rtsp://<username>:<password>@<IP address>:<port>/cam/realmonitor?channel=
<channelNo>&subtype=<typeNo>

e <username>: The user name of the system (default: admin).

* <password>: The password for the system (default: admin).

e <IP address>: The IP address of the camera.

@ NOTE

In order to view the RTSP stream over the Internet, you must port forward the RTSP port (de-
fault: 554) on your router to the system’s IP address.

¢ <Port>: The RTSP port (default: 554) of the system.

¢ <channelNo>: Enter 1.

* <typeNo>: Enter 1 for the Sub Stream of the camera or 0 for the Main Stream. It
is recommended to use the Sub Stream if connecting over the Internet.

The example below shows the correct format to connect to the Sub Stream.
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4. Click Play. The video stream will open in VLC Media Player.

If it does not connect, check the following:

Check that the syntax on the RTSP address is correct.

Make sure the system is connected to the network.

If connecting over the Internet, make sure to use the remote IP address of the system
and that the RTSP port is open.
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To perform a firmware upgrade over the LAN or Internet, a Config Tool is available from
http://www.flir.com/security/support. In an effort to continuously improve the functionality
of our products, firmware upgrades are available as a free download on
http://www.flir.com/security/support.

@ NOTE

The Config Tool is supported on PC only. Firmware upgrades can also be completed using the web
browser interface (see 6.6.7 Upgrade, page 56).

13.1 Installing a Firmware Upgrade Over the LAN
Prerequisites:

* Connect your network camera to a router or switch on your network.
¢ Download a firmware upgrade from http://www.flir.com/security/support, if one is avail-
able. Extract the contents.

To perform a firmware upgrade over the LAN:

1. Download the Config Tool from http://www.flir.com/security/support.

2. Extract the contents into a folder.

3. Open the folder and right-click ConfigTool.exe and Run as administrator. If a Win-
dows Firewall warning appears, click Allow Access. The Config Tool scans your
LAN for network cameras.

4. Click Upgrade.

6

5. Check any network cameras you would like to upgrade.

Click Open. Select the upgrade firmware file (.bin).

7. Click Upgrade. Wait for the upgrade to complete. Do not power off the system or
disconnect the power cable during upgrade. The system will restart when the up-
grade is complete.

o
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7.1.  Check network cameras
7.2.  Click Open and select firmware file
7.3. Click Upgrade
13.2 Installing a Firmware Upgrade Over the Internet

Prerequisites:

Port forward the Client Port (default: 35000) on the network camera’s local router.
Obtain the public IP address of the network camera.

Download a firmware upgrade from www.flirsecurity.com/pro, if one is available. Ex-
tract the contents.

Download the Config Tool from www.flirsecurity.com/pro.

Extract the contents into a folder.

Open the folder and right-click ConfigTool.exe and Run as administrator.

Click Login.

Under IP Address, enter the public IP address of the network camera. Edit the User
Name, Password, or Port if these have been changed from the default values.

ahrwh =

—®

Click Login. The Config Tool logs in to the network camera.

Click System Upgrade.

Click Open. Select the firmware file (.bin).

Click Upgrade. Wait for the upgrade to complete. Do not power off the system or
disconnect the power cable during upgrade. The system will restart when the up-
grade is complete.

©oN®
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e
—0

9.1. Click System Upgrade
9.2. Click Open and select the firmware file
9.3. Click Upgrade
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